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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert

symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

/\WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.

/\CAUTION

indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will

be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Trademarks

Note the following:

/\WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the

information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG A5E39439812-03-76 Copyright © Siemens AG 2020.
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Warranty and liability 1

Note

The application examples are not binding and do not claim to be complete with regard to
configuration, equipment or any contingencies. The application examples do not represent
customer-specific solutions. They are only intended to provide support for typical
applications, you are responsible for the correct operation of the described products. These
application examples do not relieve you from responsibilities of using, installing, operating
and servicing the equipment safely and professionally. When using these application
examples, you recognize that we are not liable for any damage/claims beyond the liability
clauses described.

We reserve the right to make changes to these application examples at any time and without
prior notice. If there are any deviations in the recommendations provided in this application
example and other Siemens publications, for example catalogs, the contents of the other
documents shall have priority.

We do not accept any liability for the information contained in this document. Any claims
against us — based on whatever legal reason — resulting from the use of the examples,
information, programs, engineering and performance data etc., described in this application
example shall be excluded. Such an exclusion shall not apply in the case of mandatory
liability, for example under the German Product Liability Act ("Produkthaftungsgesetz"), in
case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a
product, fraudulent concealment of a deficiency or breach of fundamental contractual
obligations ("wesentliche Vertragspflichten").

The compensation for damages due to a breach of a fundamental contractual obligation is,
however, limited to the foreseeable damage, typical for the type of contract, except in the
event of intent or gross negligence or injury to life, body or health. The above provisions do
not imply a change of the burden of proof to your detriment. Any form of duplication or
distribution of these application examples or excerpts hereof is prohibited without the
expressed consent of Siemens AG.
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Warranty and liability

1.1 Security information

1.1

Security information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement — and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Such systems, machines and components should only be
connected to an enterprise network or the internet if and to the extent such a connection is
necessary and only when appropriate security measures (e.g. firewalls and/or network
segmentation) are in place.

For additional information on industrial security measures that may be implemented, please
visit

https://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends that product updates are applied as soon as they are
available and that the latest product versions are used. Use of product versions that are no
longer supported, and failure to apply the latest updates may increase customer’s exposure
to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under
https://www.siemens.com/industrialsecurity.
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Preface 2

Purpose of this document

This document describes LUPS1600 Block Library for SIMATIC STEP 7 V5.6, STEP 7
Professional V15.1, STEP 7 Professional V16, WinCC Flexible, WinCC V7.4, WinCC V7.5,
WinCC Comfort/Advanced V15.1, WinCC Comfort/Advanced V16, WinCC Professional
V15.1 and WinCC Professional V16. The block library provides tested code with clearly
defined interfaces. You can use it as the basis for the task you wish to realize.

The main focus of this document is to describe:
® All Function Blocks (FB) pertaining to the block library.
® The functionality implemented through these blocks.

The documentation furthermore illustrates the possible operating conditions and applications
of the block library for SIMATIC STEP 7 V5.6, STEP 7 Professional V15.1, STEP 7
Professional V16, WinCC Flexible, WinCC V7.4, WinCC V7.5, WinCC Comfort/Advanced
V15.1, WinCC Comfort/Advanced V16, WinCC Professional V15.1 and WinCC Professional
V16.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, A5E39439812-03-76 7
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References

For more information on SITOP UPS1600 manuals and related documentation, refer the
following links:

Siemens Industry Online Support (https://support.industry.siemens.com/cs/start?lc=en-
us)

SITOP UPS1600 Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415)

SIMATIC STEP 7 Basic/Professional V15.1 and SIMATIC WinCC V15.1 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/109755202)

SIMATIC STEP 7 Basic/Professional V16 and SIMATIC WinCC V16 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/109773506)

SIMATIC Programming with SIMATIC STEP 7 V5.5
(https://support.industry.siemens.com/cs/ww/en/view/45531107)

WinCC flexible 2008 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/18796010)

WinCC 7.4 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/109736220)

WinCC 7.5 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/109760739)

GSD for SITOP UPS1600 for integration into SIMATIC STEP 7 V5.6
(https://support.industry.siemens.com/cs/ww/en/view/75854605)

Support Packages for the hardware catalog in the TIA Portal (HSP)
(https://support.industry.siemens.com/cs/ww/en/view/72341852)
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Task

Overview of the automation task
The figure below provides an overview of the automation task:
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Figure 3-1
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Task

Task Description

10

Your task is to equip the automation plant with Uninterruptible Power Supply (UPS). In the
event of a power failure, critical process participants are to be protected.

In the event of a power failure of the automation plant, process values are to be maintained
and plant components be safeguarded against mechanical damage by means of a defined
stopping process.

UPS is integrated into the automation network via PROFINET.

The status and diagnostic information of the UPS is displayed in the individual Human
Machine Interfaces (HMI) stations.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, A5E39439812-03-76



Structure

4.1 Solution overview
Structure
The figure below shows a schematic overview of the most important components of the
solution:
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Figure 4-1
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Structure

4.1 Solution overview

Scope of this application example

This application example provides FB1 function block for communication between the
controller and SITOP UPS1600.

It also provides faceplates and screen windows for monitoring and operation.

Note
SITOP UPS1600 is termed as UPS1600 throughout this document.

Function of the hardware components

The table below describes the function of the Hardware (HW) components used in figure 4-1:

Name Function

SITOP Power Supply Central 24 V power supply for all process devices.

Non-critical process devices Symbol for other non-critical process devices. (Devices that can be
switched off when there is sufficient pressure, for example: com-
pressors.)

SITOP UPS1600 and SITOP UPS with buffer (example, battery module).

UPS1100

S7-1214 Automation controller

Comfort Panel TP1200 Control panel for process visualization.

Other critical process devices Symbol for other critical process devices.

PROFINET Central process bus of all automation devices.

Advantages
This application offers the following advantages:
e Time and cost saving by means of FB1, HMI faceplates and screen windows.
e Easy and comprehensive introduction to integrating UPS1600 within a PROFINET
network.
Scope

This application does not include description of:

e Creating program blocks in SIMATIC STEP 7 V5.6/STEP 7 Professional V15.1.
e Creating screens and objects in WinCC flexible/WinCC TIA Portal/WinCC.

® Configuring communication between the described terminal devices.

e Handling all the described SIMATIC terminal devices.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
12 Function Manual, 04.2020, A5E39439812-03-76



Structure
4.1 Solution overview

Assumed knowledge
The user is assumed to have knowledge on the mentioned points:

e Using SIMATIC STEP 7 V5.6, STEP 7 Professional V15.1, STEP 7 Professional V16,
WinCC flexible, WinCC V7.4, WinCC V7.5, WinCC Flexible 2008 SP5, WinCC
Comfort/Advanced V15.1, WinCC Comfort/Advanced V16, and WinCC TIA Portal.

e QOperating, handling, and configuring SIMATIC S7 controllers (S7-300/400 and S7-
1200/1500).

® Operating, handling, and configuring HMI control panels (Multi Panels, Comfort Panels)
and Runtime systems (WinCC flexible Runtime, WinCC Runtime Advanced, WinCC
Runtime, WinCC Runtime Professional).

e Handling and operating SITOP UPS1600.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, ASE39439812-03-76 13
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4.2 Description of the core functionality

4.2 Description of the core functionality

Sequence of the core functionality

Communication between UPS1600 and controller runs via PROFINET. The UPS1600 is
connected to the controller as PROFINET 10 node. Thus, the entire UPS1600 information
(voltage, power, possible buffer time, battery state) is available in the controller.

In this application example, two scenarios are realized.

e The Programmable Logic Controller (PLC) via the supplied program block FB1
recognizes power failure. The information is made permanently available in the control
program which can be then evaluated. This allows your process to respond and switch off
your process devices in a defined manner.

e The Programmable Logic Controller (PLC) via the supplied program block FB2
recognizes diagnostic interrupts and generates alarm messages to WinCC.

e With the provided faceplates and screen windows, relevant information and important
parameters are displayed on the HMI control panel.

Note
FB2 is applicable only to SIMATIC STEP7 V5.6.

Overview and description of the user interface
The application example provides the following views in the faceplate:
® UPS state
® General Device information
e Qutput Data
e Voltage and power trend curves

e Currently pending alarms/alarm history

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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4.3

Hardware components

4.3 Hardware and software components used

Hardware and software components used

Component

No.

Article number

Note

SITOP UPS1600 20 A

6EP4136-3AB00-2AY0

Alternatively,
SITOP UPS1600 10 A

6EP4134-3AB00-2AY0
or

SITOP UPS1600 40 A

6EP4137-3AB00-2AY0 is
used.

MP277 8" Touch

6AV6643-0CB01-1AX5

Refer to Requirements
(Page 69).

Comfort Panel TP900

6AV2124-0JC01-0AX0

Refer to Requirements
(Page 94).

CPU 1214C DC/DC/RLY PN/DP

6ES7214-1HG40-0XB0O

Or other
S7-1200/1500 CPU

CPU 315-2 PN/DP

6ES7315-2EH14-0AB0

Or other S7-300 CPU

SITOP UPS1100 3.2 Ah (Battery module)

-

6EP4133-0GB00-0AY0

Note

The UPS1600 is upgraded with Firmware (FW) version 2.1 or higher.

Standard software components

Component No. | Article number Note

WinCC Flexible 2008 SP5 Advanced 1 B6AV6613-0AA51-3CA5 | Alternatively, WinCC
flexible 2008 SP5
Standard

WinCC Advanced V15.1 1 6AV2102-4AA03-0AE5 | Alternatively, WinCC
Comfort V15.1

STEP 7 Professional V5.6 1 6ES7810-4CC10-0YAS |-

STEP 7 Professional V15.1 1 6ES7822-1AA03-2YA6 |-

WinCC Professional V15.1 1 6AV2103-0DA03-0AA5 |-

WinCC V7.4 1 6AV6381-2BD07-3AHO | -

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7

Function Manual, 04.2020, A5E39439812-03-76
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4.3 Hardware and software components used

Sample files and projects

16

The following list in the table includes all files and projects that are used in this example:

Component

Note

LUPS1600

This folder contains the library for TIA Portal V15.1 and
master copies for STEP 7 V15.1 and WinCC V15.1.

SITOP-UPS1600_Library_STEP7-
V5_V3-0.7z

This folder contains the following subfolders.

e UPS1600 V3-0 STEP7 V5.6

e UPS1600 V3-0 library WinCC flexible 2008
e UPS1600 V3-0 library WinCC V7.4

e UPS1600 V3-0 library WinCC V7.5

UPS1600 V3-0 STEP7 V5.6

This folder contains the library of the function blocks (FB) for
SIMATIC STEP 7 V5.6.

UPS1600 V3-0 library WinCC flexible
2008

This folder contains the library of the faceplates for WinCC
flexible 2008 SP5.

UPS1600 V3-0 library WinCC V7.4

This folder contains the library of the screen windows for
WinCC V7.4.

UPS1600 V3-0 library WinCC V7.5

Tins folder contains the library of the screen windows for
WinCC V7.5.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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Function blocks 5

5.1 Function and task of the function blocks

Overview

This chapter describes the application and requirements of FB1 and FB2 and its integration
into a SIMATIC STEP 7 project.

Task description and application

® |n the event of a plant power failure, it is essential to safeguard certain machine
components against damage and to back-up process relevant data in order to prevent
data loss. The application of FB1 provides the option to bring your plant into a safe state
and switch it off in a program-controlled manner while UPS1600 buffers the voltage.

® The Programmable Logic Controller (PLC) via the supplied program block FB2
recognizes diagnostic interrupts and generates alarm messages to WinCC.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, ASE39439812-03-76
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Function blocks

5.1 Function and task of the function blocks

FB1 Function description

18

The FB1 cyclically monitors the operating mode of the UPS1600. When UPS1600 is in buffer
mode, a 10 s timer within the FB starts. This timer prevents the plant from being brought into
a safe state in the event of just a short voltage dip/drop. If the UPS is still in buffer mode after
expiry of the timer, the parameter upsreadyrorreset is set from FALSE to TRUE. Further, this
parameter is also used to bring the plant components into a safe state (maintenance mode).
When the plant is brought into a safe state, the parameter upsexecutereset is set from
FALSE to TRUE. The FB1 then sends a command to the UPS1600, which then switches off
autonomously. The following flow diagram displays the program sequence of the FB1.

Buffer mode
UPS1600

UPSReadyForReset is set

User Program

Input UPSExecuteReset must be set

y

Switching off
UPS1600

Figure 5-1

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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Function blocks
5.1 Function and task of the function blocks

Notes regarding the FB1
e [f the UPS1600 returns to the normal mode when the timer is running, the parameter
UPSReadyForReset is not set.

The timer is then reset.

e After the parameter ursexecutereset is set, the further program sequence is executed
until UPS1600 is switched off via the FB1.

® The buffer time of UPS1600 must be set such that there is sufficient time to bring the
plant into a safe state and switch off the UPS via the FB1.

Notes regarding the FB2

® |n Report system error system diagnostics blocks, alarm messages will not include
extended error information. So in order to show detailed message of interrupt, FB2 is
developed. If we use this block, no need to generate system diagnostic blocks using RSE

(Report system error).

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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Function blocks
5.2 Operating conditions

5.2 Operating conditions

Configuration
e FB1 and FB2 are approved for SIMATIC STEP 7 V5.6 and application of a CPU 300/400

e FB165 is approved for STEP 7 V15.1/STEP 7 Professional V15.1, STEP 7 V16/STEP 7
Professional V16 and application of a CPU 300/400 or CPU 1200/1500

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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Faceplates 6

The HMI faceplate displays actual values and various states of the UPS1600 on WinCC
Comfort/Advanced V15.1 and WinCC Professional V15.1.

6.1 Description

Overview

This faceplate visualizes parameters of UPS1600 on an HMI control panel:

SITOP UPS1600

State | dc-ups-20a

Normal mode . Input voltage: 23.92v

Ready for buffering . Output voltage: 23.84v

Qutput current: 0.00A

Battery charge: 100% Battery voltage: 25.29V

Battery charge current: 0.00A End of charge voltage: 27.30V
Figure 6-1

The parameters of UPS1600 are distributed over four tabs in the faceplate, clicking on the
relevant tab displays specific information. The four tabs are:

State

Information

Trends

Alarms

The contents of the tabs and the parameters are described in detail in the following sections.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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Faceplates

6.2 Slate

6.2

22

State
This menu item displays the operating state and battery state of UPS1600:

SITOP UPS1600

State dc-ups-20a
Normal mode . Input voltage: 23.92v
Ready for buffering . Output voltage: 23.84v
Output current: 0.00A

Battery charge: 100% Battery voltage: 25.29V
Battery charge current: 0.00A End of charge voltage: 27.30V

The following table shows all parameters displayed under this menu with its corresponding
display names:

Display name

Parameter of the UPS

End-of-charge voltage

Normal mode/Buffer mode bufferMode

Ready for buffering/Not ready for buffering readyForBuffering

Input voltage inputVolt

Output voltage outputVolt

Output current outputCur

Battery charge batteryChargeLevel

Battery voltage batteryvVolt

Battery Charge current measuredChargeCur
endOfChargeVolt

The values of the parameters pufferMode and readyForBuffering are output via symbolic I/O
fields. This has an indicator which is subject to the color dynamization and is dependent on

the parameter value.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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Faceplates

6.2 State

The following table shows the possible parameter states with its corresponding color

dynamization:

Parameter State/display name Color
Normal mode Normal mode Green
Buffer mode Yellow
Off White
Ready for buffering Ready for buffering Green
Not ready for buffering Red
Off White
Note

All the 1/O fields in the faceplate are read only values.
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6.3 Information

6.3

24

Information

This menu displays general device information about UPS1600:

SITOP UPS1600

Information

Device name:
Article no.:
Serial number:

HW revision:

SW revision:

Figure 6-2

dc-ups-20a

dc-ups-20a
6EP4136-3AB00-2AY0
QO6HO6AASZF5G

5

v2.3.0

The following table shows all parameters displayed under this menu with its corresponding

display names:

Table 6- 1

Display nhame

Parameter of the UPS

Device name deviceName

Article no. orderNumber

Serial number serialNumber

HW revision deviceHwRevision

SW revision deviceSwRevisionl, deviceSwRevision2, and

deviceSwRevision3
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6.4 Trends

6.4 Trends

Description
The "Trends" tab displays the following attributes of UPS1600 in trend curves:
e UPS Input voltage
e UPS Output voltage
e UPS Output current
e Battery voltage

e Battery charge current

SITOP UPS1600

Trends dc-ups-20a
50 30 uPs Input voltage
40 Il UPs Output voltage
- 2 W ups output current
Battery voltage
20
r10 Il Battery charge current
10
A 0] . o v
3:37:45 PM 3:38:35 PM 3:39:25 PM
3/12/2020 3/12/2020 3/12/2020
Figure 6-3

The time range of the X axis of the trend curve is 100 seconds. The trend variables used
have an acquisition cycle of 1 second and are refreshed cyclically.

The table below describes UPS1600 parameters with their respective display names, color
and unit representation:

Table 6- 2
Display name Parameter of the UPS Color Unit
UPS Input voltage inputvolt Green \Y
UPS Output voltage outputVolt Black \Y
UPS Output current outputCur Red A
Battery voltage batteryvolt Yellow Y
Battery charge current | measuredChargeCur Blue A

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
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6.5 Alarms

6.5 Alarms

Description
The "Alarms" tab displays PROFINET diagnostic messages of SITOP UPS1600:

SITOP UPS1600

Alarms dc-ups-20a

Pending alarms: m

Alarm history:

Figure 6-4

When you click on "OPEN" for Pending alarms and Alarm history buttons, two separate
message windows open.

The message window for "Pending alarms" displays all currently pending PROFINET
diagnostic messages of the UPS1600. The message window for "Alarm history" displays all
PROFINET diagnostic messages of UPS1600 stored in the internal message buffer of the
HMI control panel used.

Prerequisites for displaying the PROFINET diagnostic messages

In order to display PROFINET diagnostic messages of UPS1600 within the faceplate, the
respective WinCC flexible/WinCC TIA Portal project must be configured.

A list of the PROFINET diagnostic messages of UPS1600 is available in the chapter 4 of the
SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).
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71 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.1 Prerequisites

FB163 requirements

The following requirements must be met in order to use the FB in combination with UPS1600
and SIMATIC STEP 7 V5.6:

® The GSD file of the UPS1600 is installed in the Hardware (HW) configuration of SIMATIC
STEP 7 V5.6 and the UPS is configured as PROFINET node in the HW configuration of
the SIMATIC S7 controller.

e S7 communication between UPS1600 and SIMATIC S7 controller is already configured.
e The library UPS1600 V3-0 STEP7 V5.6 is available on your computer.

Installation of GSD file

The required information about installation of the GSD file of the UPS1600 in SIMATIC
STEP 7 V5.6 is available in the chapter 3.4.2 of the SITOP UPS1600 User Manual.
(https://support.industry.siemens.com/cs/ww/en/view/84977415)

S7 communication

The required information about establishing communication between a UPS1600 and a
SIMATIC S7 controller is available in the chapter 3.4 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.2 Content of the library for SIMATIC STEP 7 V5.6

Content of the library for SIMATIC STEP 7 V5.6
The library UPS1600 V3-0 STEP7 V5.6 contains:
e Blocks (FB1, FB2, UDT1 and UDT2)
e Symbol table Symbols_UPS1600
e SCL source file of the code blocks FB1, FB2, UDT1 and UDT2
® "Text Libraries"

The table below shows the blocks available in the library.

Table 7-1

Block Name Description

FB1 UPS1600 FB for program-controlled switch-off of the
UPS1600

UDT1 LUPS1600_typeUPS1600Data UDT provides the structure in the global data
block for data exchange

FB2 UPS16Msg FB to raise UPS1600 diagnostic alarms

uDT2 SStartinf UDT structure of local data of OB82
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Opening the library in SIMATIC STEP 7 V5.6
Follow the procedure to open the library in a SIMATIC STEP 7 V5.6 project:
1. Open SIMATIC Manager.

2. In the menu bar, click "File > Open".
The "Open Project" dialog box opens.

3. Select the "Libraries" tab.

Open Project @

User projects  Libraries ] Sample projects | Multipmiects]

Mame | Storage path -
&2 CFC Library C:\Program Files [xB6NSIEMENSYY =
e LavishTry_Lib C:\Program Files [RBB]NSIEMENS\E‘ =
&2 PCS 7 AP Library V&1 C:\Program Files [«BENSIEMENSAS
@2 PCS 7 BasisLibrary ¥81 C:\Program Files [«86]\SIEMENSAE
@ PCS7_KT_Lib C:\Program Files [+BENSIEMENSAS
2 PSUSE00 V2 STEPT VS C:\Program Files [#8E\SIEMENSAE
2 PSUSEO0 STEPT V5_5 D:MLibraryh 102373345 SITOP_PSI
& PSUSE00 V2 STEP7 VS D:\Sthaprilh102379345_SITOP_PS _
]| P——m— o T

Selected

User projects:
Libraries:
Sample projects:

Multiprojects: Browse...
Cancel Help

Figure 7-1
4. Click "Browse".
The "Browse" dialog box opens.

5. Navigate to the stored location of the library in your computer and open the folders
"SITOP-UPS1600_Library_STEP7-V5_V3-0 > UPS1600 V3-0 STEP7 V5.6".
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

6. Select "UPS1600_" and click "OK".

Browise

Find in directong:

|J?'\S?LIBS\UF'S1 B00%3-0 STEPY %5.6\Ups1600_

STMANLAL
STMET
STNGD
STNVE
S7Proj

=fren

Found Selected
Usger projects;
Libraries: 1 1
Sample projects:
Multiprojects:

User projects  Libraries lSampIe projects | Fultiprojects |

M ame | Storage path
@ UPSTB00Y3 ... C:\Program Files [86]\Siemenz\Step7s

Figure 7-2

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, A5E39439812-03-76

30

Cancel Help




Application of the function blocks

713

Block diagram

Interfaces of the function block

The following figure shows the block diagram of FB1:

DE3

"Upsleno_

oE"

FB1

"URSleont
-|EH

—addrIn

cyclicI0f
—ddr

UPSExecut
—{eReset

—data

TPEReadyF

ENO |~

orBeset [~

Figure 7-3

Interface description

The table below describes parameters of FB1:

7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

Table 7- 2

Parameter Declaration | Data type Description

addrin Input DWORD PROFINET diagnostic address of the
UPS1600 within the project.
The diagnostic address must be
specified in hexadecimal format.

cyclicIOAddr Input WORD Input address of the UPS1600 within
the project.
The input address must be specified
in hexadecimal format.

UPSExecuteReset | |npyt BOOL Switch-off signal to the UPS1600.

UPSReadyForReset | Qutput BOOL Signal for plant shutdown.

data InOut LUPS1600_typeUPS1600 | Data area for data exchange to the

Data HMI faceplate.
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The table below describes parameters of FB2:

Table 7- 3

Parameter Declaration | Data type Description

Diag_Address Input INT PROFINET diagnostic address of the UPS1600
within the project. The diagnostic address must be
specified in decimal format.

%gg%g%g%gg_g% Input DWORD Message event ids for Device failures alarms

MSIEVISI0T-9% - |Input DWORD Message event ids for Device Diagnostic alarms

%28%3%%%857% Input DWORD Message event ids for Battery Diagnostic alarms
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Input and diagnostic address of the UPS1600 module

To fetch the input and diagnostic address of the UPS1600 module, follow the instructions
given below:

1. Open the hardware configuration settings of the PLC used in the project. The "HW
Config - [SIMATIC 400(1) (Configuration)..." dialog box opens.

2. Select the UPS1600 module.

3. Note down the value in the "Diagnostic Address" column (A). We need to add value to the
given parameter addrin of FB1 and piag Address of FB2.

4. Note down value in the "l Address" column (B), value given to the parameter
cyclicIOAddr of FB1.

] SIMATIC 400(1) (Configuration) - UPS_Test =2 EER 5
(o) uR2aLU H
1 PS 407 44 @ B
2 CPU 416-3 PN/DP
IF1 Ethernet(1): PROFINET 10 system (100
X1 MELDP | Y
X5 PO =L
XEPTA Poit 1 r (1] ups20
X5P2R Fort 2
] L W 20
5
6 =
< | m 3
&= 1) w20
Slot Module Order number | Address | [ address Diagnostic Address Com... |
z Pt EEPSTF6-BAB00-2AY0 (Ay—l[7ez7% ] =
DPevice svesace Do svesace FEFTE" F
Pt 15 Pt 7 TR
Pt SR Pt F 6T E
ar LFSTRT A AV PR
&z LIFETERR A Y sz 58 | ——B £
i UPS1100 DC 24V 1,28h 10~ GEP4131-0GB00-04Y0 16374
2
3 -
Figure 7-4
In this case,

® .ddriIn valueis 16375.

® cyclicIOAddr is 512.
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.4 LUPS1600_typeUPS1600Data (UDT1)

Data block DB15

The Data Block (DB) contains all the parameters of UPS1600 displayed within the HMI
faceplate.

The following table lists all the parameters in UDT1:

Parameter Data type Remarks
orderNumber STRING [20] Order number (String)
serialNumber STRING [20] Serial number (String)
deviceName STRING [20] Device name (String)
versionNumber STRING [30] Version number (String)
batteryCapacity REAL [Ah]
endOfChargeVolt REAL V]

chargeCur REAL [A]

maxOutCur BYTE [A]

inputvolt REAL V]

inputCur REAL [A]

outputVolt REAL [V]

loadCur REAL [A]
measuredChargeCur REAL [A]

batteryVolt REAL [V]

outputCur REAL [A]

chargeVolt REAL [V]

bufferMode BYTE Active = 255 Inactive = 0; Undefined = 127
readyForBuffering BYTE Yes =255;No=0
batteryChargeLevel BYTE 0 to 100% = battery charging; 255 = unknown battery
totalCalcBatCap REAL [Ah]
totalCalcBatHealth BYTE [%]

bufferTime INT [s]

bufferThreshold REAL [V]
bufferingAllowed BYTE [0/255]

commandID INT Remote reset = 8195
parameterl BYTE -

parameter2 BYTE -

deviceHWRevision INT -

deviceSWRevisionl BYTE -

deviceSWRevision2 BYTE -

deviceSWRevision3 BYTE -
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

Note

Further information about the system parameters is available in the SITOP UPS1600 User
Manual (https://support.industry.siemens.com/cs/ww/en/view/84977415).

7.1.5 Integrating the function block

Integrating FB1

The following sections describe all the steps required to integrate FB1 into a SIMATIC
STEP 7 V5.6 project.

Hardware used:
e CPU 317-2 PN/DP
e SITOP UPS1600 24 V/20 A

The procedure for other SIMATIC S7 controllers is identical.

Note

Please ensure that all requirements for the integration of the FB are met. The requirements
are described in these Prerequisites (Page 27).

Inserting blocks from the library into the program

Follow the procedure to integrate FB1 and associated data blocks into a SIMATIC STEP 7
V5.6 project:

1. In the "SIMATIC Manager", open the required project.
2. Open the "Blocks" folder available in the connected PLC.

3. In the "SIMATIC Manager", open the global library UPS1600 V3_0 STEP7 V5_6 and
select "UPS1600_V3_0 > Blocks".
The procedure for opening the library is described in Content of the library for SIMATIC
STEP 7 V5.6 (Page 28).
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36

4.

5.

Select all the blocks in the library and drag-and-drop them into the "Blocks" folder of your
target project folder.

| SIMATIC Manager - UPS Test
File Edit Insert PLC ‘“iew Options Window Help

D@ |22 s 2e|d|s %2 & |[ < NoFiter> -7 @ BEMmN

& UPS1600'¥3_0 STEPT WS_6 (Companent View) - CAUsers\&drministratoriDesktopUPS1600 STEPT 5.84Ups1600_ (===

E-§2 UPS1E00Y3 0STEF?VE_6 = 0BT 43 FB1 @Fe2  @UDTT @UDTZ Z3 SFB4 QSFB32 &3 SFBB3 g3 SFB54
E=-{z UPS1600_v3_0 SFCE g3 SFC14 g3 SFC18 g3 SFC20 g3 SFCS0 g3 SFC70 g3 SFCT

(B] Sources
[» -{gq Blocks
--{32] Text Libraries

@ UPS Test (Cnmpunent\liew) -- Chllsers\&dministrator\Desktop\LIPS_Test @

E@ UPS_Test iS5 System data: 43 OB1 v
CHE SIMATIC 400(1)

- =-[f cPU 4163 PN/DP

H =z 57 Program(2)
Sources

Blocks

i (=] Test Libraries

- SIMATIC HMI Station(1]

Figure 7-5

Note

The function blocks work properly with both, English and German mnemonics. In case
the source code of the function blocks is required for a project, consider the following
constraints:

¢ In case the language setting of your project is English, then the source code of the
function blocks can be used as it is.

¢ In case the language setting of your project is German, then the entries IB (Input Byte)
and IW (Input Word) of the sources have to be replaced with EB (EingangsByte)

Insert OB40 in order to avoid PLC going to stop mode in case of hardware interrupt.
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Inserting Text libraries from the library into the program
Follow the procedure to insert "Text Libraries" from the library into a SIMATIC STEP 7 V5.6

project:

1. In the "SIMATIC Manager", open the required project.

2. Open the "S7 Program" folder available in the connected PLC. Insert Text Library folder
under S7 Program folder if it doesn’t exist.

3. In the "SIMATIC Manager", open the global library UPS1600 V3_0 STEP 7 V5_6 and
select "UPS1600_V3_0".

4. The procedure for opening the library is described in Content of the library for SIMATIC
STEP 7 V5.6.

5. Copy "SITOP_MODULES", "SITOP_UPS1600_DiagText", "SITOP_UPS1600_HIpText"
which are present under "Text Libraries" folder in the library and paste them into the "Text
Libraries" folder of target project folder.

6. Open text library "SITOP_MODULES" and make an entry to the text library with index as
modules diagnostic address and PSU8600/UPS1600 device name under English/
German Language column as shown below.

S At userte Wlran - SUPSLesb I AN 0= 11216 1 =R =4 Pregia=a 1l eat Dilesne b D= SA0CETE 5
Iede D= % ewr r-dome el -
CeH & - E= R N R e
| WUPE Te: AEIMAZTIC 40260790 16-3 20,7374 ET ProyranndziiTeeed Libee a2, TT0_MACDULE

Lladex Engliceh (Umited Stateel

1 IG=TH =z

Figure 7-6

7. Save and close text library.
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Create a global data block with UDT structure

Follow the procedure to create a global DB with UDT:

1. In your project, open the "Blocks" folder available in the connected PLC folder.

2. Right-click on the blocks element area and select "Insert New Object > Data Block".
The "Properties - Data Block" dialog box opens to create a DB.

3. In the "Properties - Data Block" dialog box,
— Enter a name and number for the DB (DB15) in the "Name and type:" text box.
— For the same field, open the first drop-down list and select "Shared DB".

— Enter a symbolic name as desired (UPS_Global) in the "Symbolic Name:" text box.

Properties - Data Block @

General - Part 1 | General-Part2] Calls ] Attributes]

Mame and type: |DB15 |Shared DB j | _I
Symbolic Mame: |UPS_Glabal

Symbaol Comment; I

Created in Language: DE -
Project path: |
=1 locati
S S [C:\Program Files (<8ENSIEMENS\S TEPTAsTproj\Praject_
Code Interface
Date created: 09/15/2016 11:38:06 Ak
Last modified: 09/415/2016 11:38:06 AM 09/415/2016 11:38:06 AM
Comment: 2

Cancel Help

Figure 7-7

4. Click "OK".
The created DB appears in the "Blocks" folder.

5. Open the DB created in Step 2 (DB15).

A new window opens.
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6. At the address "+0.0",

7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

— In the "Name" column, enter a name for your tag (UPS).
— Inthe "Type" column, replace INT with LUPS1600_typeUPS1600Data.

— In the "Initial" column, delete the initial value and remove the comment.

Address |Name Type Initial wvalue |[Comment
[} STRUCT
+0.a |DB_W&P\I INT L u} Temporary placeholder wariable
=z2.0 END_STRUCT
Address |Name Type Initial walue [Comment
STRUCT

o m—

+0.0| [ues

"LUPS1€00_typeUPS1&00Data™

=172.0

STRUCT

Figure 7-8

7. Save the settings and close the window.
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Calling the function block FB1

Follow the procedure to call the FB within an organization block (OB). In this description,
FB1 is called within OB33:

1. In the "Blocks" folder of the controller, create an instance DB.

2. Right click on the blocks element area and select "Insert New Object > Data block". The
"Properties - Data Block" dialog box opens.

3. In the "Properties - Data Block" dialog box,

— Enter a name and number for the DB (DB3) in the "Name and type:" text box.

— For the same field, select "Instance DB" and "FB1" from the drop-down lists.

— Enter the symbolic name as "UPS1600_DB" in the "Symbolic name:" text box.

— Click "OK".
Properties - Data Block @
General - Part 1 | General - Part 2 ] Calls ] Attributes |
Mame and type: |DE3 |Instance DB j |FB1 j
Symbolic Mame: |UF'S1 E00_DE|
Symbol Comment: |
Created in Langquage: DE -
Praject path: |
St locati
Df%r;gi;act?ca an |E:'\Users\.&dministratnr\D esktophJPS_Test
Code Interface

Date created: /27,2020 11:35:44 AM
Last modified: /27,2020 11:35:44 AM 01/27/2020 17 35: 44 AM
Cormment:

Cancel Help

Figure 7-9
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4. In the same "Blocks" folder, create an Organization Block (OB) with the name OB33.
(Right click and select "Insert New Object > Organization block".)

Open the created OB33.

%% LAD/STL/FBD - [OB33 -- "CYC_INT3" -- Project_UPS16004SIMATIC 300(INCPU 317-2 PN/DPY.NOB... E =] @
iF File Edit Insert PLC Debug View Options Window Help

[=[[=] %]

&0 Bit logic
(X1 Comparator
(&g Converter
(#1] Counter
(o8] DB call

(5] Jumps

-(z1] Integer function 2
(%] Floating-point fii|
-] Move

{3 Program contral
(23] Shift/Rotate

i-{a7] Status bits

H-(@] Timers

1-(Z3 Word logic

H-igH FE blocks

i-{£H FC blocks

FEm O = O B rm N = O B e W = B e WO = O v
1 R R R e

[

-

A
=]

'Environment’ Interface'

(W= = = B o |tihdda|a |26
i) b #OF L 1R
_I}J |Contents 0f:
E"@ Interface |Nane
B New network - & TEMP 4a| TEMP
1 =

0B33 : "Cyclic Interrupt"

Comment :

Figure 7-10

5. In the "Program elements" tab, expand the "FB blocks" folder.
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"; LAD/STL/FBD - [OB30 -- UPS_Test\SIMATIC 400(1)\CPU 416-3 PN/DP]

i@ File Edit Inset PLC Debug

View Options Window Help

6. Drag-and-drop "FB1 UPS1600 UPS1600" onto the empty network area.

N@:HGlsmeo|cilc%e O OEEERHHOML 2 (W)
EL e e
4@ Interface A [ [name
- B New network m. A7 roun v [

Bit logic
@-{Z] Comparator
=-{ag Converter
Counter
(o8] DB call
=-{&] Jumps
[-{z0) Integer function
-{£8 Floating-point fct.
- Move
-@3f Program control
(&) Shift/Rotate
Status bits
#-{@] Timers
(& Word logic
=-E8 FB blocks

S Yre162 UPS160D UPST600

OB30 : Title:

|Comment -

o

L0} FB164 UPS16Msg UPS1600
@-{£8 FC blocks
{3 SFB blocks
E-{£8 SFC blocks
‘ Multiple instances
- M Libraries

Figure 7-11

??7?
"UPS1e00"
[EN ENO
.. —fjaddrIn UPSReadyF
orReset |—...
cyclicIOR
.. —fddr
JUPSExecut
-. —jeReset
-.-—gdata
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7. For the block in the network area,

Interconnect FB1 with the instance DB created in step 1 (DB3).

For the parameter addrin, enter the PROFINET diagnostic address of the SITOP
UPS1600 within your STEP 7 project (DW#16#3FF7).

For the parameter cyclicroaddr, enter the input address of the SITOP UPS1600 within
your STEP 7 project (W#16#200).

Connect the parameter ursreadyForreset to the tag through which you bring the plant
into a safe state (flag M0.0 is used).

Connect the parameter ursexecutereset to the tag through which you switch off the
UPS (flag M0.1 is used).

DB3
“UPS1600_
DE*
FB1
“UPS1600°
EN ENO
DW#16#3FFT 4 addrIn TP SReadyF

orEeset ...
cyclicIOf
W#16#200 4 ddr

PSExecut
M0, 1 HeRezet

P#DE1. DEED
.0
“TPS_
GLOBAL®.
PS5 —data

Figure 7-12

For further information about the block parameters, see Interfaces of the function
block (Page 31).

8. Save the changes and close the window.

Note

addrin and cyclicIOAddr of FB1

To know the diagnostic and input address of FB1, refer to section Input and diagnostic
address of the UPS1600 module in Interfaces of the function block (Page 31).

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, ASE39439812-03-76 43



Application of the function blocks

7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

Calling the function block FB2

Follow the procedure to call the FB2 within an organization block (OB). In this description,

FB2 is called within OB82:

1. In the "Blocks" folder of the controller, create an instance DB.

2. Right click on the blocks element area and select "Insert New Object > Data block". The
"Properties - Data Block" dialog box opens.

3. In the "Properties - Data Block" dialog box,

— Enter a name and number for the DB (DB2) in the "Name and type:" text box.

— For the same field, select "Instance DB" and "FB2" from the drop-down lists.

— Enter the symbolic name as "UPS1600Msg_DB" in the "Symbolic name:" text box.

— Click "OK".
Properties - Data Block @
General - Part 1 | General - Part 2] Calls ] Abtributes |
Mame and type: |DB2 |Instance [u]:] j |FB2 j
Symbolic Mame: |UF'S'I Bkzg DB
Symbol Comment: |
Created in Langquage: 0]} -
Praject path: |
St locati
i et [C:\Program Files (+6B)SIEMENS\STEP7AS 7ProfIPS_T est
Code Interface
Date created: 01/27/2020 11:76: 35 Ak
Last madified: 01/21/2020 11:16:35 Ak 01/21/2020 11:16:35 Ak
Comment;
|
Cancel Help

Figure 7-13
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4. In the same "Blocks" folder, create an Organization Block (OB) with the name OB82.
(Right click and select "Insert New Object > Organization block".) Open the created
OB82.

[ LAD/STL/FBD - [OB82 -- "I/O_FLT1" -- Praject_UPS1600\SIMATIC 400(1ACPU 416-3 PN/DPY,.\OB82] [fol]l® =
i3 File Edit Insert PLC Debug Wiew Options MWindow Help HEE

Dl & s BR[o o tdo%e <o O] e
= x|

|Contents 0f: 'Environment’Int
=] @ Interface |Nane -
G TEMP 4@ [TENP

9 New network

3] Bit logic

g Eomp:atm 0BS2 : "I/0 Point Fault" m

&g Converter | 4

(& Counter Conment :

{og] DB call

(5] Jumps

Integer function

% Floating-point fct. |
Mowe

] Program control |

{z) Shift/Rotate

Status bits

=-{@] Timers

#-{Z) Word logic

{£H FB blocks

4R FC blocks -

»

- - B

E3]
¥
5

&

B Y ricle:

e
m

[
EJ

[
B

&

[

1)

E:I Program elements IE_E Call structure | .E Nelwcuks] 2=

Press F1to get Help. D [offline Abs <52

Figure 7-14

5. In the "Program elements" tab, expand the "FB blocks" folder.
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/STL/FBD - [OB80 -- "CYCL_FLT" -- UPS_Test\SIMATIC 400(1\CPU 416-3 PN/DI

6. Drag-and-drop "FB2 UPS16Msg UPS1600" onto the empty network area.

£ File Edit Insert PLC Debug \‘iew Options MWindow Help [=]=]x]
D@s-WH(E % 2R o |thaala|2a ||
OE BB M| %% oo #-OF L 2 (N2
EE Contents 0f: 'Environuent)Interface'
E @ Interface | Name -
I New network B B4 TEMP <@ [ TEMP
G0 Bit logic =
=] Comparator =
@ Converter 0B80 : "Cycle Time Fault" D
&-E] Counter
=-{0g] DB call
=-{g] Jumps
(20 Integer function
(2R Floating-point fct, PP
- Move = "UPSLeMsg"
-8 Program control 1 ENOD
@-{z) Shift/Rotate s
. iag_
' ffat"'s bits .. —address ERROR | ..
imers
-2 Word logic MsgEvId00
-8 FB blocks S b
45 FBL_UPSI600 UPS1600 S——
= FE2 UPS16Msg UPS1600 .2
(-8 FC blocks L
&8 SFB blocks et
€3 SFC blocks o
..fll Multivle instances i MsgEvId0o
/UPS1600 £ o
M=gEvIdon
)= s ~
H]ngram.,. )
Figure 7-15
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8.

7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

. For the block in the network area,

— Interconnect FB2 with the instance DB created in step 1 (DB2).

— For the parameter piag address, enter the PROFINET diagnostic address of the
SITOP UPS1600 within your SIMATIC STEP 7 project (16375).

15375+

DuWglefc00n
0ool —

DWglega00n
ooz —

DIglegannn
o003 —

DIglegannn
o004 —

DIglegannn
ooos —

DIglegannn
oooe —

DIglegannn
o077 —

DuWglefc00n
ooos —

DuWglefc00n
0o0s —

DuWglefc00n
000A —

DuWglefc00n
000E —

DuWglefc00n
oooc —

DBEZ
"OPS1eM=qg_

oE"

FEZ

EN

Diag
Address

M=yEwIddo
1

M=gEwIddo
z

M=gEwIdAOo
3

M=gEwIdAOo
4

M=gEwIdAOo
£

M=gEwIdAOo
g

M=gEwIdAOo
7

M=yEwIddo
g

M=yEwIddo
3

M=yEwIddl
o]

M=yEwIddl
1

M=yEwIddl
Z

Figure 7-16

"TRSleM=g"

ENO

ERROR [—. ..

Save the changes and close the window.

Follow the same procedure to call FB2 in OB86 and cyclic interrupt OB. In this example
OB33 with the same instance DB which is created in step 3.

Note
Diag_Address of FB2

To know the diagnostic and input address of FB2, refer to section Input and diagnostic
address of the UPS1600 module in Interfaces of the function block (Page 31)
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7.2 Application of the function blocks under STEP 7 Professional V15.1

7.21 Prerequisites

Requirements

The following requirements must be met in order to use the FB in combination with UPS1600
and STEP 7 V15.1:

e Hardware Support Package (HSP) for UPS1600 is installed in STEP 7 V15.1.
® S7 communication between UPS1600 and SIMATIC S7 controller is already configured.

e LUPS1600 is available on your computer.

Installation of Hardware Support Package

The required information about installation of Hardware Support Package of UPS1600 in
STEP 7 V15.1 is available in the chapter 3.3.2 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).

S7 communication

The required information about establishing communication between UPS1600 and a
SIMATIC S7 controller is available in the chapter 3.3 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).
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7.2 Application of the function blocks under STEP 7 Professional V15.1

7.2.2 Content of the library for STEP 7 V15.1

Content of the library for STEP 7 V15.1
The STEP 7 V15.1 library contains the library elements for:
e S7-300/400
e S7-1200/1500

The following sections describes in detail about the library elements and how to open the
library in STEP 7 V15.1.

Library elements S7-300/400 and S7-1200/1500

The following code blocks are present in this library element:

Table 7- 4
Folder | Description
FB It contains the LUPS1600_UPS1600 function block for program-controlled switch-off of the

UPS1600.

ubDT

LUPS1600_typeUPS1600Data UDT stores all parameters of UPS1600.

Opening the library in STEP 7 V15.1
Follow the procedure to open the library in STEP 7 V15.1 project:

1. Open STEP 7 V15.1 in the "Project view" and select the "Libraries" tab.

2. Under the "Global libraries" palette, click on the highlighted icon to import the library. The
"Open global library" dialog box opens.

Libraries w M p

Options

#| Library view [£] -

W

Global libraries

e st i a—] B
G [ d ST Gi B
» L] Buttons-and-Switches
» LI Long Functions

» LI Monitoring-and-control-objects

» Ll Documentation templates
» L WinAC_MP

Figure 7-17

3. In the "Look in:" drop-down list, navigate to the stored location of the library folder
LUPS1600 on your computer and open it.
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4. Select "LUPS1600".

Lok in: || LUPS1600 - @F P E
P Marrie - * | Date modified Type
'*)L? AdditionalFiles 3202019 2:22 PR File folder
Recent Places M 3/20/2019 222 PM  File folder
! Iystem 372072019 2:22 PR File folder
‘ THAP 372042019 2:22 PM File falder
Desktop UserFiles 372042019 2:22 PM File falder
— HRef 37202019 2:22 PM File folder
,;L:iJ Q LUPS1600 3/12/2019 3:55 PM Siernens T
Libraries
A
Cormputer
@ 4 | m [ 3
File name: LUPS1600 - Open
Metnork [g
Files of type: [Global library v] [ Cancel ]
[¥] Open as read-only
Figure 7-18
5. Click "Open".

The library is displayed in the "Global libraries" palette.
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7.2.3

7.2 Application of the function blocks under STEP 7 Professional V15.1

Function block FB165 for S7-300/400

Block diagram

Interfaces of the function block FB165

The following figure shows the block diagram of FB165:

DB
"LUPS1600_
UPS1600_DE"
BEET1ES
"LUPS1800_LIPS1600"
= EN ENG —
addrin upsReadyFarRe
cycliclOaddr set—
upsExecuteRes
- et
data
Figure 7-19
Interface description
Parameter Declaration Data type Description
addrIn Input DWORD PROFINET diagnostic address of
the UPS1600 within the project.
The input address can be speci-
fied in both hexadecimal and
decimal format.
cyclicIOAddr Input WORD I/O Data input address of
UPS1600 within the project. The
input address can be specified in
both hexadecimal and decimal
format.
upsExecuteReset Input BOOL Switch-off signal to the UPS1600
data InOut LUPS1600_typeUPS1600 | Data area for data exchange to
Data the HMI faceplate.
upsReadyForReset | Qutput BOOL Signal for plant shutdown
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addrIn and cyclicIoaddr of FB165 for S7-300/400
To fetch the input and diagnostic address of the UPS1600 module for S7-300/400, follow the

52

instructions given below:

1. In the "Project tree", open "Devices and Networks".

2. Select the UPS1600 module and go to "Device view > Device overview".

3. Note down the value in the "l address" column (A), this value is given to the parameter

addrIn.

4. Select the UPS1600 module and go to "Properties > General > |/O data > I/O

addresses > Input addresses”

5. Note down the value in the "Start address" variable (B), this value is given to the

parameter cyclicIoaddr.

Project_LUPS1600 » Ungrouped devices » DC-UPS-20A_1 [UPS1600 20A PN]

IE'? Topology view ||n-§-n Network view "I]f Device view |_
nﬁﬂ' 4 Eﬁ J Device overview |
ﬂ‘ . | Module Rack Slot | address
B ~ DCUPS20A_1 o (A—|2082 |
i » PROFINETinterface o 0 Devi... 2041*
" 0 1
B 0 2
. 0 3
0 o 4
Rack_0 0 5
v} 6
[ <[ —5— @ (<] i | >
|_@, Properties H"_i.'.lnfo "i] Diagnostics I
J General h 10 tags || System constants h Texts |
» General [ IO add
» PROFINETinterface [X3] adaresses
PROFINET security Input addresses
» Device configuration
w |i0 data Start address: |256 I—@) ]
General End address: |263 |
Inputs T -
Process image: |Ncnr:
» Web server Interrupt OB number: |4O
Figure 7-20
In this case,

® Value of addrin is 2042 (A).

® Value of cyclicroaddr is 256 (B).
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7.2 Application of the function blocks under STEP 7 Professional V15.1

Function block FB165 for S7-1200/1500

Block diagram

The following figure shows the block diagram of the FB165:

DB
"LUPS1600_
UFS1600_DE"
%FBTES
"LUPS1600_UPS1500"
= EN EMO —
addrin upsReadyFarke
cyclicloAddr SEL=—
upsExecuteRes
- et
dats
Interface description
Table 7- 5
Parameter Declaration | Data type Description
addrln Input HW_lO Hardware ID of the UPS1600
within the project, for example:
DC-UPS-20A_1~Head.
cycliclOAddr Input HW_IO |0 Data submodule address of
UPS1600 within the project
upsEecuteReset Input BOOL Switch-off signal to the UPS1600
data InOut LUPS1600_typeUPS1600 | Data area for data exchange to
Data the HMI faceplate.
upsReadyForReset | Qutput BOOL Signal for plant shutdown
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7.2 Application of the function blocks under STEP 7 Professional V15. 1

addrIn and cyclicIoaddr of FB165 for S7-1200/1500

To fetch the input and diagnostic address of the UPS1600 module for S7-1200/1500, follow
the instructions given below:

1. In the "Project tree", open "Devices and Networks".

2. In the "Network view", select the UPS1600 module and go to "Properties > System
constants".

3. Note down the value in the "Hardware identifier" column of DC-UPS-20A_1~Head (A),
value given to addrin.

4. Note down the value in "Hardware identifier" column of DC-UPS-
20A_1~IO_Data_Submodule (B), value given to cyclic1oadadr.

Project_UPS1600 » Devices & networks

I; Topology view ||ﬁ%t| Network view ||[|‘f Device view |

& Metwork un Conhnections | HM| connection |'| & Relations B !I;, ik H
PMNAE_2 [#]
PLC_1 DC-LPS-204_1 HMI_1

CPU 1214C UFS1600 204 FN TF1200 Comfort
FLC_1
| .
PNAE_1

v | | =g

(<[] 100% -] ¢ ®
IgPrnperties ”"i'.lnfu y"ﬂ Diagnostics 1

| General ” 10 tags ” System constants || Texts I
Marme Type Hardware iden... Comrent
Hardware interrupt Event_Hwint 16#C0000112
DC-UPS-20A_1~Proxy Hw_SubModule 272
DC-UPS-204_1~Head Hiw_SubModule 273 —®
DC-UPS-204_1~10-Data_submaodule Hw_SubModule 274
DiC-UPS-20A_1~FROFINET intedace Huw_Interface 275
DC-UPS-204A_1~FROFIMET interface~Fort_1 Hw_Interace 276
DiC-UPS-20A_1~FROFIMET intedace~Fort_2 Hw_Intedace 277

Figure 7-21

In this case,

® Value of addrin is DC-UPS-20A_1~Head or 273 (A).
® Value of cyclicroaddr is DC-UPS-20A_1~I0-Data_Submodule or 274 (B).
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7.2.4 LUPS1600_typeUPS1600Data

The data block contains parameters of UPS1600 displayed within the HMI faceplate.
The following table lists parameters present in LUPS1600_typeUS1600Data:

Parameter Data type Remarks
orderNumber STRING [20] Order number (String)
serialNumber STRING [20] Serial number (String)
deviceName STRING [20] Device name (String)
versionNumber STRING [30] Version number (String)
batteryCapacity REAL [Ah]
endOfChargeVolt REAL V]

chargeCur REAL [A]

maxOutCur BYTE [A]

inputvolt REAL V]

inputCur REAL [A]

outputVolt REAL [V]

loadCur REAL [A]
measuredChargeCur REAL [A]

batteryVolt REAL [V]

outputCur REAL [A]

chargeVolt REAL [V]

bufferMode BYTE Active = 255 Inactive = 0; Undefined = 127
readyForBuffering BYTE Yes =255;No=0
batteryChargeLevel BYTE 0 to 100% = battery charging; 255 = unknown battery
totalCalcBatCap REAL [Ah]
totalCalcBatHealth BYTE [%]

bufferTime INT [s]

bufferThreshold REAL [V]
bufferingAllowed BYTE [0/255]

commandID INT Remote reset = 8195
parameterl BYTE -

parameter2 BYTE -

deviceHWRevision INT -

deviceSWRevisionl BYTE -

deviceSWRevision2 BYTE -

deviceSWRevision3 BYTE -
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7.2.5 Integrating the function block
7.2.5.1 Procedure when using an S7-300/400
Overview

Hardware used:

e CPU 315-2 PN/DP

e S|TOP UPS1600 24V/20A

The procedure for other SIMATIC S7-300/400 controllers is identical.

Note

Please ensure that all the requirements for the integration of the FB are met. The
requirements are described in the Prerequisites (Page 48).

Inserting blocks from the library into the program

Follow the procedure to insert the FB165 and associated data blocks into a STEP 7 V15.1
project:

1. Open the required project in "Project view".
2. In the "Libraries" window, under "Global libraries", open the library "LUPS1600".

The procedure for opening LUPS1600 global library is described in Content of the library
in STEP 7 V15.1 (Page 49).
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3. In the library, select "Types > LUPS1600 > STEP7 > S7-300/400 > FB >
LUPS1600_UPS1600".

Libraries w0 p

Options
El Library wiew [E=4] ;[
> Project library

S’ISB_LKW'I

~ : Global libraries
Frhue e Bk
» Ll Buttons-and-Switches

» LI Long Functions
» LIl Monitaring-and-control-abjects

saueiqr] E”

» Ll Documentation templates
w L] Lurs1600
v [5] Types
w [&] LUPS1600
« [&:] STEP?
w [i:] 57-300/400
w [t:] FB
| » " LUPS1600_UPS1600 |
» [tz UDT
» [t S7-120001500
» L) WinCC
» [ Master copies
» [} common data
» | Languages &resources

Figure 7-22

4. Drag-and-drop "LUPS1600_UPS1600" into the "Program blocks" folder in the "Project
tree".

Project tree a 4

Devices

v | 7 Project_LUPS1600 ~]
B Add new device B
gﬁh Devices & networks

» ([l PLC_1 [CPU 1214C DC/DC/RKy]
~ [[§ PLC_2 [CPU 315-2 PN/DP]

[I'f Device configuration

%] Online & diagnostics

L3 Technology objects
External source files
Ea FLC tags

[ PLC data types

[z watch and force tables
rj"' Online backups

Figure 7-23
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Note

Even "LUPS1600_typeUPS1600Data" will be automatically copied to the "PLC data types"

folder in the "Project tree".

Project tree

Devices

[
£

~ | ] Project_LUPS1600
“b' Add new device
g Devices & networks
» [ PLC_1 [CPU 1274C DD CRIY]
~ [[§ PLC_2 [CPU 315-2 PN/DFP]
[IY pevice configuration
%] online & diagnostics
» g Program blocks
» [ Technology objects
4 External source files
» L4 PLCtags
v [ PLC data types
B Add new data type
w [&:] LUPS1600
¥ [&] STEP?
« [i:] 57-300/400
« [&:) uDT

| ' LUPS1600_typeUPS1600Data
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Calling the function block

Follow the procedure to call FB165 within an Organization Block (OB). In this description,

FB165 is called within OB35:

1. In the "Project tree", open the "Program blocks" folder.

2. Create a cyclic interrupt OB with the name "CYC_INT5 [OB35]" and open it. This displays

an empty network.

3. From the "Program blocks" folder, drag-and-drop "LUPS1600_UPS1600 [FB165]" to the
empty network of OB35. The "Call options" dialog box opens.

Project tree

Devices

m 4

[t

> | ] Project_LUPS1600
B Add new device
ﬁgh Devices & networks

~ [[§ PLC_2 [CPU 315-2 PN/DP]
[I‘f Device configuration
%] online & diagnostics
= [.gl Program blocks
B Add new block
2 Main [OB1]

» [ PLC_1 [CPU 1274C DCDCRI]

i

| 48" LuPs1600_UPS1600 [FE165] | | ——

4 [&5 Technology objects

» External source files

Figure 7-24

HF HiF 0~ — £

¥ Block title: "Main Frogram Swe

Comment

¥  Network1: .

Cormment

4. Keep the default settings of the dialog box and click "OK".

5. Double click on "Add new block" to add a new DB. The "Add new block" window opens.
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. In the "Add new block" window,

Select "Data block"

Enter a name as desired (UPS_Global).

In the "Type:" drop-down list, select "Global DB".
Click "OK".

Add new Mu(

]

[ ]
Global DB

& LUPS1600_UPS1600 [FB164]
] LUPS 1600_typeUPS 1600Data
ABS_PARATYPE
CAM_PO16TYPE
CAM_PO32TYPE
CAM_PD64TYPE
CAM_P128TYPE

Figure 7-25
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7. Open the global DB created in step 6 (UPS_Global). Add a new tag with data type as
"LUPS1600_typeUPS1600Data".

Project_LUPS1600 » PLC_2 [CPU 315-2 PN/DP] » Program k

Devices

[ : B | == B, B = "7 Keepactualvalues [gg Snapshot %
UPS_Global
v | 7 Project_LUPS1600 [~ Name Data type Offset
B Add new device | @ v static
ﬁgh Devices & networks 2 <= » ups l
» [ PLC_1 [CPU 1214C DC/DC/RKy] Real
ot [ﬂ PLC_2 [CPU 315-2 PN/DP] S5Time
u'f Device configuration = String
13| Online & diagnostics Struct
« |gl Program blocks Time Il
‘;‘ Add new block Time_Of Day =
3 CYC_INTS [OB35] Word
& Main [OB1] R "LUPS1600_typeUPS1600.f »

@l LUPS1600_UPS1600_DB [DB1]
[ @ UPs_Global [DB2] |

» [%:] LUPS1600_FB

Figure 7-26

8. In the network area of OB35,

Note

OBs are called cyclically and in numerical order. Observe this when calling the
communication blocks in an operation block. This ensures that you are reading the
current data of the power supply.

— For the parameter addarin, enter the PROFINET diagnostic address of the UPS1600
module (2042).

— For the parameter cyclicioaddr, enter the start address of the UPS1600 module (68).

— Connect the parameter upsreadyrorreset With a tag of your project that you use to
bring the plant into a condition in which it can be shut down.

— Connect the parameter upsrxecutereset With a tag of your project that you use to
switch off the UPS when the plant is in a condition in which it can be shut down.
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— Connect the parameter data with Global DB UPS_Global.

%ROE1
"LUPS1AO0_
UFS1600_DEB"
WEBTES
"LUPS1600_LUPS1a00"
EN ENO

2042 — addrin upsReadyForRe  hMO.S

68 — cyclicloaddr set —i"Tag_2"

W02 ypsExecuteRes

"Tag_3" — et

PHDE2.DEX0.0

"UP5_alobal".ups data

Figure 7-27

Note
addrin and cyclicIoaddr parameters

To know the addrin and cyclicioaddr parameter values of the UPS1600 module, refer to
Interfaces of the function block FB165 (Page 51).
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7.2.5.2

Overview

7.2 Application of the function blocks under STEP 7 Professional V15.1

Procedure when using an S7-1200/1500

Hardware used:

e CPU 1214C DC/DC/RIly

e SITOP UPS1600 24 V/20 A

The procedure for other SIMATIC S7-1200/1500 controllers is identical.

Note

Please ensure that all requirements for the integration of the FB are met. The requirements
are described in the Prerequisites (Page 48).

Inserting blocks from the library into the program

Follow the procedure to insert the blocks and the associated data blocks into a STEP 7
V15.1 project:

1. Open the required project in "Project view".

2. In the "Libraries" tab, under "Global libraries", open the library "LUPS1600".
The procedure for opening the library is described in the Content of the library in STEP 7
V15.1 (Page 49).
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. In the library, select "Types > LUPS1600 > STEP7 > S7-1200/500 > FB >

LUPS1600_UPS1600".

Libraries

Options

=] Library view 2]

¥  Project library

X0q|oo| El

~  Global libraries

FdhHuwx
» Ll Buttons-and-Switches
» LLl Lang Functions
» Ll Manitaring-and-contral-objects
» LUl Documentation templates
w ||| LUPS1600
~ [5] Types
w [t LUPS1600
~ [&:] STEP?
» [tz 57-300/400
« [tz 57-1200M1500
« 5| FB

suonewiuy B

=
-1}

£
=]
=
=

| » © "LUPS1600_UPS1600 |

» £z UDT
b (5 WinCC

» || Master copies
» [L} Common data
¥ Languages & resources

Figure 7-28

tree".

Project tree m 4
Devices

GO =) &

gy Devices & networks E‘
~ [i§ PLC_1 [CPU 1214C DC/...
[IY pevice configuration
%) Online & diagnostics
' Program blocks I
E Technology cbjects

External source files
Ea PLC tags

ETJ PLC data types

L;l Watch and force tab...
[i; Online backups

v v v v v v w|w

e
=8 Traces

Figure 7-29

suopInIsu| I_%e”

|

]

4. Drag-and-drop "LUPS1600_UPS1600" into the "Program blocks" folder in the "Project
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7.2 Application of the function blocks under STEP 7 Professional V15.1

Note

Even "LUPS1600_typeUPS1600Data" will be automatically copied to the "PLC data types"

folder in the "Project tree".

Project tree m 4
Devices
~ | ] Project_LUPS1600

ﬁ"".ﬁ\dd new device
gy Devices & networks
« [ PLC_1 [CPU 1214C DD CRE]
Y pevice configuration
%) online & diagnostics
» rﬂ. Prograrm blocks
» [ Technology objects
» External source files
» [4 FLCtags
w [ PLC data types
ﬁ Add new data type
=[] LUPS1600
- [iz] STEF?
« [&] 57-1200/1500
w [&] UDT
| ] LUPS1600_typelUPS1600Data

2]
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7.2 Application of the function blocks under STEP 7 Professional V15.1

Calling the function block

Follow the procedure to call the FB within an organization block (OB). In this description,
FB165 is called within OB30:

1. In the "Project tree", open the "Program blocks" in the controller.

2. Create an OB with the name "Cyclic interrupt [OB30]" and open it. This displays an empty
network.

3. Drag-and-drop "LUPS1600_UPS1600 [FB165]" from the "Program blocks" folder to the
empty network of OB30. The "Call options" dialog box opens.

Project tree m 4
Devices

5 Ed R EE LN

Cyclic interrupt

| Project_UPS1600 =
B Add new device | A A == —
gy Devices & networks
~ [ PLC_1 [CPU 1214C DGDCRY]
Y pevice configuration ¥  Network1: .
%) online & diagnostics
i EL Prograrn blocks
ﬁ.ﬂ\dd new block J/
W Cyclicinterrupt [0B30] —
& Main [OB1] vd
| % LUPs1600_UPS1 600 [FB1 |/ |

» Block title: ...

Camment

4. Keep the default settings of the dialog box and click "OK".

5. Double click on "Add new block" to add a new DB. The "Add new block" window opens.
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7.2 Application of the function blocks under STEP 7 Professional V'15.1

6. In the "Add new block" window,

Select "Data block".

Click "OK".

Add iew block

Enter a name as desired (UPS_Global).

In the "Type:" drop-down list, select "LUPS1600_typeUPS1600Data".

upsGlobal] |

Figure 7-30
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7.2 Application of the function blocks under STEP 7 Professional V15. 1

7. Right click on the global DB created in step 5 (UPS_Global) and go to "Properties >
General > Attributes".

8. In the network area of OB30 for FB165,

— For the parameter addrin, enter the hardware ID of DC-UPS-20A_1~Head of the
UPS1600 (281).

— For the parameter cyciicroaddr enter the hardware ID of DC-UPS-
20A_1~Data_submodule of the UPS1600 (282).

— Connect the parameter upsreadyrorreset With a tag of your project that you use to
bring your plant into a condition in which it can be shut down.

— Connect the parameter upsrxecutereset With a tag of your project that you use to
switch off the UPS when the plant is in a condition in which it can be shut down.

— Connect the parameter data with the global DB created in step 6, (UPS_Global).

HOE
"LUPS1600_
UPs1600_DEB"
%FET16S
"LUPS1600_UPS1600"
EN ENO

281 upsReadyForRe  BMOS
"DZ-UPS-204,_ set —1"Tag_4"

1~Head" addrin

282

"DiC-UPS-208,_

1~ O-Data_
subrnodule” — suclicioaddr

05 ypsExecuteRes
"Tag_3" — et

%WOE2
"UPS_clobal" — data

Figure 7-31

Further information about the block parameters, refer to Interfaces of the function block
FB165 (Page 51).

Note
addrin and cyclicIoaddr parameters

To know the addarin and cyclicioaddr parameter values of your UPS1600 module, refer to
Interfaces of the function FB165 (Page 51).
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8.1 Application of the faceplates in WinCC flexible 2008

8.1.1 Prerequisites

Requirements

The following requirements must be met to use the faceplates in WinCC flexible 2008 SP5:

The GSD file of the SITOP UPS1600 is installed in SIMATIC STEP 7 V5.6 and UPS is
configured as PROFINET node in the HW configuration of the CPU.

S7 communication between SITOP UPS1600 and CPU is already configured.

All the program blocks from the library UPS1600 V3_0 STEP 7 V5_6 are integrated into

the STEP 7 application program and executable.

The library 'UPS1600 V3_0 library WinCC Flexible 2008' for WinCC flexible 2008 SP5 is

available on your computer.

Supported control panels

The faceplates are supported for the following control panels:

TP270 10"

OP270 10"

MP270 10" Touch

MP277 8" Touch/Key

MP277 10" Touch/Key

MP377 Touch/Key

WinCC flexible Runtime 2008 SP5

Supported languages

The faceplates support the following languages:

English (USA)

German (Germany)

e Chinese (PR China)
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8.1 Application of the faceplates in WinCC flexible 2008

8.1.2 Library for WinCC flexible
Library for WinCC flexible
The library 'UPS1600 V3_0 library WinCC flexible 2008' for WinCC flexible 2008 SP5
comprises of the following objects:
Table 8- 1
Name Type Description
UPS1600 V3_0 HMI Tag table Tag folder A tag folder with all the required tags
Faceplate_UPS1600_V3_0 Faceplate Contains the faceplate 'Face-
plate_UPS1600_V3_0'.
HMI Alarm views Message window | Contains two message windows for displaying
diagnostic messages of the UPS1600
UPS1600_Data Structure Contains a group of structure elements re-
quired for UPS1600 faceplate
8.1.3 Integrating the faceplates
Overview
The following sections describe all the steps required to integrate a faceplate into a WinCC
flexible 2008 SP5 project.
Hardware used:
e MP277 8" Touch
An overview of the supported HMI control panels is available in the Prerequisites (Page 69).
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8.1 Application of the faceplates in WinCC flexible 2008

Opening the library
The following procedure describes how to open the library in WinCC flexible 2008 SP5:
1. Open the WInCC flexible project into which you want to insert the faceplate.

2. In the "Tools" window, select the "Library" tab and click on the highlighted icon to open
the library. The "Open global library" dialog box opens.

@ x
3

Simple Objects
Enhanced Objects

Graphics

Library

Mo libraries opened,

Usethecontextmenu, thetoolbarordrop
objects hereto create aropen libraries,

Drop any objecthere to delete

HI it.

Figure 8-1
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3. Click the "Look in:" drop-down list and browse to the stored location of the library "SITOP-
UPS1600_Library_STEP7-V5_V3-0 > UPS1600 V3-0 library WinCC flexible 2008" on

your computer.

Lookin: | |1 UPS1600Y30 ibrary 'winCC flesible 2008 FlemxcEes -

D UPS1600% 3 0 librany WinCC Flesible 2008, wif

>
L
System Libraries
Sl

Iy Libraries

File name: LIPS1800%3_0 libram WinZC Flexible 2008, wlf -

Stand-alone

-

File bype: WinCLC flexible libraries]”. wif]

| Open || Cancel | |

Figure 8-2
4. Select "UPS1600 V3_0 library WinCC flexible 2008.wlf" and click "Open".

This imports the library into your project.
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Inserting faceplates into a project

The following procedure describes how to integrate the faceplate from the library into an
existing WinCC flexible project:

1. Open the required WinCC flexible project.

2. In the "Project" window, open the screen into which you want to insert the faceplate

(Screen_1).
@
less Project o~

EI..; SIMATIC HMI-Station(1)[MP 277 8"
- & Screens

—a Add Screen

----- Template
[=-+g Lommurication
Tags

® Connections
Cycles

=4 Alarm Management
----- B2 Analog Alarms
----- BR Discrete Alarms

m

[z Settings
-4y Recipes
(- Historical Data
-4 Scripts
-0 Reports
(-4 Text and Graphics Lists
(-5 Runtime User Administration
(- Device Settings

(=43 Language Settings

----- @ Project Languages
----- HE Graphics -
= Project Texts
(-4 Dictionaries

Figure 8-3

3. In the "Tools" window, under the "Library" tab, select the faceplate element
"Faceplate_UPS1600_V3_0".

4. Drag-and-drop "Faceplate_ UPS1600_V3_0" into the opened screen.
@&

>

SIEMENS i zflese @
- Simple Objects
. 5 JUSESEREE | Enhanced Objects
= == Graphics
Pending alarms Dby
Q Project library
Show pending alarms @ New Library
(3 UPS1600 V3_0library WinCC Flexible 2008
o N
Alarm history — EH ; e
= “©= ==
Show alarm history - -

| . ]
Faceplate | HMI Alarm UPS1600 UPS1600_
UPS1600..| | Views V2 0 HM. Data

Figure 8-4
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5. In the "Project" window, select "Screens" and open "Template".

T
leas Project

usas SIMATIC HHI-Station[1)(MP 277 8"
=R ‘o Screens

I:I Template

~~~~~ 1 Screen_1

=gt Communication

..... <= Tags

~~~~~ - ¢* Connections

~~~~~ =& Cycles

=+ Alarm Management

~~~~~ B4 Analog Alarms

~~~~~ BE Discrete Alarms

(H-eg Settings

|-+ Recipes

[-4g Historical Data

[+4: Scripts

" Reports

<42 Text and Graphics Lists
g Runtirme User Adminiztration

s Device Settings

B ) Language Settings

----- @ Project Languages

E_ Graphics T

Froject Texts

- o Dictionaries —

m

&
Ll il g |

Figure 8-5

6. In the "Tools" window, select the "HMI Alarm views" element of the library.

7. Drag-and-drop "HMI Alarm views" into the template. Two message windows are inserted.

..... k_f,/'b’ﬁli_"’n’ ﬁf
Simple Objects

f| Enhanced Objects

I Graphics

Library
9 Project library
i New Library

() UPS1600 V3_0library WinCC Flexible 2008

_IZIE] =
[ -]
\_
| -]
Faceplate_ HMI Alarm| UPS1600 UPS
UPS1600... V3_0 HM.. D

Drop any object here to delete

“ it.

Figure 8-6

8. Select "Alarmview_UPS_Pending" alarm window, right-click on the "Properties" and
select "Properties > Display > Enable "ACK" button". Repeat the same procedure for
enabling "ACK" button in "Alarmview_UPS_History" alarm window.

9. In the "Project" window, select "Communication > Tags".
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10.In the "Tools" window, select the "UPS1600 V3_0 HMI tag table" library element.

—
, x|
ix Lo @ ‘
Simple Objects
Enhanced Objects
Graphics

Library

% Project library

% New Library

“([J UPS1600 V3_0 library WinCC Flexible 2008

=

Faceplate_ HMI Alarm|| UPS1£00 (| UPS1800_
UPS1600... Views ||M3 0 HM.. Data

I] Drop any object here to delete it.

Figure 8-7
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11.Drag-and-drop "UPS1600 V3_0 HMI tag table" into the "Tags" folder.

laas Project
Elpmar SIMATIC HMI Station(1)MP 277 10" Touch)
-5 Screens
.33 Add Screen
-[_] Template
-.[] Screen_1
(-5 Communication
(== UPS51600 V3_0 HMI tag table
-----.S' Connections
- Cycles
=4 Alam Management
B4 Analog Alamms
- B8 Discrete Alarms
[H-“&g, Settings
14 Recipes
H-4g Historical Data
-3 Reports
-4 Text and Graphics Lists
t
H
¥

A ﬁ- Runtime User Administration
- Device Settings
Language Settings
----- & Project Languages
----- B Graphics
----- = Project Texts
(g Dictionaries
- Structures
(- Version Management

W0 O OO e VOO e O e O OOy OO

Figure 8-8

12.0pen the tag table "UPS1600 V3_0 HMI tag table", for the "UPS_Data" tag,

— In the "Connection" column, select the required connection. (The connection name

must be identical to the name of the connection created during configuring connection
to the controller.)

— Assign the global DB "UPS_GIlobal" number to the tag (DB15).

EEmEmmETTIOTTY

Name Symbol (Address Arrayelements d
= alarmpending | <Undefined> <No address> i 1s
alarmhistory <Undefined > <No address > 1 1s
= UPS_Data | <Undefined> ~|DB 150BW 0 Bl 50|

Range DB ~

|DB 15 ]
] —
=
Figure 8-9
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13.In the tag table, select the tag "alarmhistory". Check the properties of the tag where in the

"ShowAlarmWindow" function is inserted and its variable "Object name" is assigned to
the tag "Alarmview_UPS_History".
If the "Properties" window does not open then right click on the tag and go to "Properties".

[ Sereen 1 T ~=1JPS1600 ¥2_1 HMI tag table

{::;j-.:-.. mbol|

B

IM [ Addisses:

%[ Faceplate_intern_alarmwiew_buffer ]::Internal tags j::Nn address > <IIndefin
£ Faceplate_intern_alarmview_pending | <Inkernal tag: <o address > <Indefin
E  UPs Data 37 conneckion_1 DB 1 DEW O <IIndefin
(€
B cHmia) ][] Function List
P Froperties
P Events E showalarmWindow
® Change value T 7 -
® High limit jeck na . armview_UPS_History
B Low limit Display mods Toggle
2 <Mo functionz
Figure 8-10

Similarly, check the properties of the tag "alarmpending" where in the
"ShowAlarmWindow" function is inserted and its variable "Object name" is assigned to
the tag "Alarmview_UPS_Pending".

If the "ShowAlarmWindow" function is not inserted for these two tags, refer to the section
Adding "ShowAlarmWindow" function to the tags described below.

14.Select the faceplate inserted in step 4 (Screen_1) and go to "Properties > Dynamic

Interface".
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15.Under the "Data" section, for the "UPS_Data" property assign the "UPS_Data" tag created

in step 11.
W Properties e
 Dynamic Interface s
o, ayout Yisivility
m Misc
® General
alarmhistor: ¥ 1s
P Animations Faceplate_Intern_alarmview_buffer l ¥ _] |
Faceplate_Intern_alarmview_pending |B|Bme€"diﬂg j |1S =
ot i
UPS_Data |UPS_Data | [s00ms
Qicon [Name ||
xS 2fjic 1 Station(1)

ication = |UPS_Data

s
ETE T | s 1600 V3 D HMI tag tab
[ 400(1)
416-3PN/DP
S7 Program(3)

Figure 8-11

16.Under the "Visibility" section, for the "Faceplate_intern_alarmview_buffer" property insert
the "alarmhistory" tag from the "UPS1600 V3_0 HMI tag table" tag table.

W Properties 2
P Dynamic Interface i

M tayoub Wisibility o

m Misc s

m General [ 2 fa
i alarmhistor: > 1s e

D Animations Faceplate_Intern_alarmview_buffer ¥ J | :

2 Project ~

Faceplate_Intern_alarmview_pending ||=-yues SIMATIC HMI Statiol <Undefined >
E&--J;{? Communication -z alarmhistory
Data H E-<= Tags 2= alarmpending

L= UPS160(
UPS_Data |2 UPS_Test
- SIMATIC 400(1)
< >||< =-[§ cru416-3F
=-{57] 57 Progr
@ Sym o
b
>

<

— __ |
[ o> || New | [

Figure 8-12

Similarly, for the "Faceplate_intern_alarmview_pending" property insert the
"alarmpending" tag from the "UPS1600 V3_0 HMI tag table" tag table.

Note
Connection in the UPS1600 V3_0 HMI tag table

A default connection is always created automatically when a project is created. Delete the
default connection if you have created another connection for your project.
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Adding "ShowAlarmWindow" function to the tags

The following procedure describes how to add the "ShowAlarmWindow" function to
"alarmpending" and "alarmhistory" tags in the "UPS1600 V3_0 HMI tag table" tag table:

1. Select the "alarmhistory" tag. A new window opens.
2. Go to "Events > Change value".

3. Click on "<No function>".
4

. In the drop-down list select "System functions > Alarms > ShowAlarmWindow".

EEmEmETrTery

£ alarmpending <Undefined> “No 2
g alarmhistory I J<Undeﬁned> j <No address> 1 1
E  Ups_Data <Undefined> DB 15DBW 0 1 500 ms
P EE| Function List
) Properties
.4 E’vent: : il <No function> v
Change value
= High "gmitv . [=- System functions A
;o (- All system functions
u Low limit & Alarms
.~ ClearAlarmBuffer
i -ClearAlarmBufferProtoolLegacy
i i-SetAlarmReportMode
ShowAlarmWindow
.. ShowSystemAlarm
(- Calculation v
Figure 8-13

5. For the "Object name" variable click on "<No value>".
6. In the drop-down list select "Alarmview_UPS_History".

Follow the same procedure for the "alarmpending" tag, add "ShowAlarmWindow" function
and select "Alarmview_UPS_Pending" for the "Object name" variable.

Displaying the PROFINET diagnostic messages

To display the PROFINET diagnostic messages of UPS1600 within the faceplate, the
respective WinCC flexible project must already be configured.

Information on the display and configuration of diagnostic messages in WinCC flexible is
available in the entry ID 22319131
(https://support.industry.siemens.com/cs/ww/en/view/22319131).

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 are
available in the chapter 4 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).
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Connecting trends of the faceplates with data sources

The following procedure describes how to create and connect trends to a faceplate:

1. Open WInCC project and select "Communication > Tags > UPS1600 V3_0 HMI tag table"
and open the tag table.

ks Prfec
FJ!!- SIMATIC HMI Station(1{MP 277 107 Touch)

80

-5 Screens
.3 Add Screen
----- ] Template

(-5 Communication

El""@

== UPS1600 V3_0 HMItag table |

----- 25 Connections

..... =% Cycles

-4 Alam Management

----- Analog Alams

----- BR Discrete Alarms
(-5 Settings

-4 Recipes

-4 Historical Data

Scripts

-4 Reports

|-+ Text and Graphics Lists
-58 Runtime User Administration
(- Device Settings
=g Language Settings

vvvvv @ Project Languages

vvvvv E Graphics

= Project Texts

(- Dictionaries

H- Structures

(- Version Management

-

()

(]
{5 o ]l iy g )
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Figure 8-14
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2. In the tag table, create a new tag.

In the "Symbol" column, click the drop down box, navigate to the global DB tag created in
the project (UPS_Global) and select "inputVolt" tag. (Here, select "Project > UPS_Test >
SIMATIC 400(1) > CPU 416-3PN/DP > S7 Program(3) > DB > UPS_Global > UPS >

inputVolt".)
EEmEmmEorTs
Name Connection Symbol Address Array
alarmpending <Internal tag> <Undefined> <No address > 1
alarmhistory <Internal tag> <Undefined> <No address> 1
UPS_Data 57 connection_1 <Undefined> DB 15DBW 0 1
UPS_Global.UPS.inputvolt S7 connection_1 jinput\!olt ~|DB 15DBD 112 *|1
bject Icon (Name
UPS_Test orderNumber A
- SIMATIC 400(1) serialNumber
=-[@ cpu 41-3PN/DP deviceName
! =-{27] 57 Program(3) versionNumber
[ (-43) Symbols batteryCapacity
| =-{£8 b8 endOfChargeVo
[]-45 DB1 chargeCur
-4 ups maxOutCur
-4 DB3 s i "’“ttc“t
-4 s utputiolt
-4 DB12 loadCur
ﬂ' UPS_Diag D) measuredCharg
E]ﬂ UPS_Global batteryVolt
&-{3 ups outputCur
[-45 UPS1600_DH chargeVolt v
< > < >l

Figure 8-15

3. Repeat step 2 to create four more tags and assign the following symbols:

— outputVolt

— outputCur

— batteryVolt

— measuredChargeCur

[] Screen_1 | <= Taos | -=1JPS1600 V3_0 HMI tag table
Name (Connection Symbol (Address
alarmpending <Internal tag> <Undefined> <No address >
alarmhistory <Internal tag> <Undefined> <No address>
UPS_Data 57 connection_1 <Undefined> DB 15DBW 0
|UPS_Global, UPS.inputyolt S7 connection_1 :J inputVolt ~|DB 15DBD 112 :l
UPS_Global.UPS.batteryVolt S7 connection_1 batteryvolt DB 15DBD 132
UPS_Global.UPS. measuredChargeCur 57 connection_1 measuredChargeCur DB 15DBD 128
UPS_Global.UPS. outputCur 57 connection_1 outputCur DB 15DBD 136
=| UPS_Global.UPS.outputVolt S7 connection_1 outputVolt DB 15DBD 120
Figure 8-16

4. Select the faceplate in your screen and go to "Properties > General".

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, ASE39439812-03-76 81



Application of the faceplates

8.1 Application of the faceplates

in WinCC flexible 2008

5. Under the "Trends" section, select the "Trends" variable to add trends to the faceplate. A
new window appears.

" SIEMENS

Alarm history

Show alarm history

) Properties
B General
’ Animations

X position

Y position
v Misc

Layer

Object name
v Trends

Trends

v Visibility

E: late_Intern alarosien

Féceplate_l ntern_alarmview_buffer

Faceplate_ UPS1600 V3 0

Figure 8-17

6. In the window, add five trends.

— In the "Samples" column, enter 600 points for the trend representation.

— For "Trend type", select "Realtime Cyclic Triggered".
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8.1 Application of the faceplates in WinCC flexible 2008

In the "Source settings" column, for each of the trends assign the data sources in the
"Trend tag" variable:
Trend 1: inputVolt

Trend 2: outputVolt
Trend 3: outputCur
Trend 4: batteryVolt

Trend 5: measuredChargeCur

Source settings Foreground co... [Side Display
[UPS_GLOBAL.ups.inputvolt] v |00, 255, 0 ~|Right  ~|Lines

(= =]=]

0 Right Lines
Trend tag [;LOBAL.ups.inputyolt l] , 0 Right Lines
Trend_4 Ples ect Icon [Name
Trend_S SIMATIC HMI Stationi1) <undefined > -
%ﬂ Communication == alarmhistory <Mo address| |
EILE Tags += |alarmpending <o addressi|
sz UPS1600 W3_0HMI tag table | == |UPS_GLOBAL.ups.batteryvolt DB 1 DBD 13
8 UPS_Test = PS_GLOBAL.ups.inputyolt IDB 1DED 11
A <= UPS_GLOBAL.ups.measured... DB 1 DBD 12
, <= UPS_GLOBAL, ups, oukputCur DE 1 DBD 13
4 2= 1IPS @NRAL nne cubnnbale MR 1 NRM 17
; < [ 1 J | < | i
. | el | | Mew |
e e e e T
Figure 8-18

Also, set the "Pulse" value to 0.5 s for each of the trends.

e 5

as!
Name Source settings Foreground co... |Side Display

= Trend_1 [UPS_GLOBAL.ups.inputvol] v |0, 255, 0 v|Right ¥ |Lines

= Trend_2 0 Right Lines

= Trend_3 Trend tag LOBAL.us.in MR ~| P, 0 Right Lines
Trend_4 = 156, 0 Left Lines

= Trend_S |Pulse de= 3‘ EC | 255 Left Lines
— [7] %] »

In the "Foreground color" column, select the trend colors for the individual outputs
according to the legend.

Trends
. Input voltage
. Charge current
. Battery voltage
. Output current

. Output voltage
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8.1 Application of the faceplates in WinCC flexible 2008

— Inthe "Side" column, select the side as "Right" for voltage related tags (Volts scale)
and "Left" for current related tags (Ampere scale).

o = iE =]

[l avhe | |

= Trend_1 [UPS_GLoBAL. ups.inputiolt]

[ o, 255, 0 Right Lines

Trend_2 [UPS_GLOBAL.ups. outputyalt] [ [ Right Lines
= Trend 3 [UPS_GLOBAL.ups.batteryvolt]  [llzss, 0,0 Right Lines
= Trend 4 [UPS_GLOBAL.ups.measuredCha, ., [L0]255, 156, 0 Left Lines

Srends s closalups.outpurcur] [0 0,255 vfieft <luines
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8.2 Application of screen windows in WinCC V7.4

8.2.1 Prerequisites

Requirements
The following requirements must be met to use the screen windows in WinCC V7.4:

® The GSD file of the SITOP UPS1600 is installed in SIMATIC STEP 7 V5.6 and the UPS is
configured as PROFINET node in the HW configuration of the CPU.

® S7 communication between the SITOP UPS1600 and CPU is already configured.

® All program blocks from the library UPS1600 V3_0 STEP7 V5_6 are integrated into
STEP 7 application program and executable.

® The library UPS1600 V3-0 library WinCC V7.4 is available on your computer.

e Existing WinCC OS (PC station) with already configured connection and active
communication.

PC Station
The screen windows are supported for the following PC Station:
® WinCC V7.4 Runtime

Supported languages
The screen windows support the following languages:
® English (USA)
® German (Germany)
® Chinese (PR China)
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8.2 Application of screen windows in WinCC V7.4

8.2.2 Library for WinCC V7.4
Library for WinCC V7.4
The library UPS1600 V3-0 library WinCC V7.4 for WinCC V7.4 comprises the following file
folders:
Table 8- 2
Name Type Description
HMI Tag table (WinCC V7.4) Tags File for tag import
HMI Screens (WinCC V7.4) Screens Comprises screen 'UPS1600_V3_0.pd!I'

HMI Tag table (WinCC V7.4)

This folder contains the file UPS1600_HMIUDT.txt. This text file comprises all the tags and
structure required for the functioning of UPS1600 screens.

HMI Screens (WinCC V7.4)
This folder contains the screen UPS1600_V3_0.pdl.
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8.2 Application of screen windows in WinCC V7.4

8.2.3 Integrating the screen windows

Overview
Target system used:
® WinCC V7.4 Runtime

Inserting the project screens

The following procedure describes how to insert the HMI screen from the library into the
project directory of your WinCC project:

1. Open "Windows Explorer" in your computer machine and navigate to the "GraCS" folder
in your project directory. Here, path to the folder is: "C:\Program
Files(x86)\SIEMENS\STEP7\S7Proj\Ups1600\wincproj\OS(2)\GraCS".

2. Open another instance of "Windows Explorer" in your computer machine and navigate to
the stored location of the "SITOP-UPS1600_Library_STEP7-V5_V3-0" library folder.

3. In the library folder, open "UPS1600 V3-0 library WinCC V7.4".

4. Copy the "UPS1600_V3_0.pdI" screen element from the library and paste it into the
"GraCS" folder.

(=@ =]
@Uv\ |« UPS16.. » HMIScreens (WinCC YT.4) ~ | 43 | | Search Mt Sereens (winCC v7.4) o
Organize » Include in library = Share with = Mew folder = ~ [l |@|
& Favirites ~ Mame Date rmodified Type Size
Bl Desktop ‘i‘ |¢, LUPS1600_43_0 1071572017 9:47 PM WinCC.Graphics.Du., 1,019 KB I
& Downloads
£ Recent Places
=
@Uv‘ <« wincproj b O5(2) » GraCs - ’ +y ’ ‘ Search GraCl e |
Organize A Open = New folder =~ [l @
b Caorites ‘;‘ Marre Date modified Type Size
BE Desktop . || |#] UPS1600_%3_0 104152017 9:47 PM WinCC.Graphics.D.., 1,019 KBl
4 Downloads =] WTDesigns 12710/2019 3:39 PM XML Docurnent 36 KB
£ Recent Places
il Libraries
‘i*] Documents
= - 4 T »
Figure 8-19
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8.2 Application of screen windows in WinCC V7.4

Importing tags

88

Studio" window opens.

1. Open your WinCC project in WinCC Explorer.

The following procedure describes how to import the HMI tag table file from the library folder
into your WinCC project:

2. Open the "Tag Management" element. The "Tag Management — WinCC Configuration

4% WinCC Explorer - C:\Pragram Files (<86 SIEMEMSASTERTysTproj\Praject i, |- = |[ &

File Edit ‘View Tools Help
>l > "X =l E] 3 =

=g OS(1)
----- @ Computer

|_ ..... I Tag Management I

----- M Graphics Designer

----- = Alarm Logging

----- 111 Tag Logging

----- d Report Designer

..... 1. Global Script

..... Text Library

..... 55 Text Distributor

----- i}} User Administrator
----- 5 " Cross-Reference

----- _%_, Server data

----- @ Redundancy

----- _U _} User &rchive

----- ':—] Time synchronization
.....v‘;;. Haorn

----- "I,'- Picture Tree Manager
g Lifebeat Maonitoring
»»»»» _[ _| Component List Editor
----- SFC

" Web Navigator

Mame

@Computer

'" Tag Management

A Graphics Designer
i Alarm Logging
;|;|;|Tag Logging
aRepnr‘t Designer
1. Global Script
fText Library
525 Text Distributor

iii User &dministrator
_s:!'Cross—Referente
_iServer data
gRedundancy
J;UUserArchive

':-:lTime synchronization
i Horn

? Picture Tree Manager
Q:.Lifebeat Maonitaring
i, 0% Praject Editor
11Campanent List Editor
= SFC

%Web Mavigatar

Type
Computer
Tag Managerment
Editor
Editor
Editor
Editar
Editor
Editor
Editor
Editar
Editor
Editar
Editor
Editor
Editor
Editor
Editor
Editor
Editor
Editor
Editor
Editor

< | 1}

Press F1for Helo.
Figure 8-20

22 obiect(s)
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8.2 Application of screen windows in WinCC V7.4

3. In the "Tag Management" window, select "Structure tags".

m Tag Management - WinCC Configurz
File Edit View Help

Tag Management «

E‘ulll Tag Management
: = # Internal tags
@~ I SIMATIC 57 Protocal Suite
E!F_f_'g Structure tags
#-1g @AssetControlStruct

lil»»v'v‘fj @Maintenance

IJ] Tag Logging
i -

Ready | NUM  Scrol \

Figure 8-21

4. In the menu bar, select "Edit > Import". The "Import" window opens.

5. Browse to the stored location of "SITOP-UPS1600_Library_STEP7-V5_V3-0" library
folder in your machine and open "UPS1600 V3-0 library WinCC V7.4 > HMI Tag table
(WinCC V7.4)".

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, ASE39439812-03-76 89



Application of the faceplates

8.2 Application of screen windows in WinCC V7.4

6. Select "UPS1600_HMIUDT".

1 mport
@Ov| |« UPSIE0.. » HMITag table (WinCC T.4) = | 49 ][ Search M1 Tag tavie pwincC .. P |
Organize » New folder = = [ @
e orites MNarne : Date modified Type 5
Bl Desktop | UPS1600_HMIUDT TA0F2017 12:15 Akd Text Document |

4 Downloads

:
=l Recent Places

m

o Libraries
E] Docurments
& Music
[E] Pictures

M Camniter ][ < | LI} | b

File name: UPS1600_HMILDT ~ | Unicode text (o) -

| Impot | | cancel |

Figure 8-22

7. Click "Import". "UPS1600_Data" structure tag element appears under "Structure tags" in
"Tag Management" window.

mn Tag Management - WinCC Configuration Stuc
Eile Edit View Help

Tag Management «

=4 Tag Management
: o Internal tags
. @ 1| SIMATIC S7 Protocol Suite
=-F Structure tags

w4 @AssetControlStruct

¢ @Maintenance

|

Figure 8-23

1Y P S1600_Data |

8. Close the window.
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Configuring screen windows

8.2 Application of screen windows in WinCC V7.4

The following procedure describes how to configure a screen window:

1. In the WinCC project, select "Graphics Designer".

2. On its right window pane, right click on the empty space and select "New picture" option

to add a new pdl file.

45 WinCC Explorer - C\Program Files G@GRSIEMENS\STER s TprajiProject wincprof0... [ = || & |

File Edit ‘iew Tools Help
o lmy | X = eaE | ?
=g OS(L Marne =
““““ O3 Computer A @1001.pDL T
---- I Tag Management A @@ConfigTypica Seen
| A Graphics Designer | A @@Maintenance] | Mesw pictute
<<<<< A Alarm Logging M @alarmActive.PD Graphic OLL

““““ 1] Tag Logging

---- ﬁ Report Designer
Qe ;

d e Global Script

Text Library

-5 Text Distributor

---- i User Administratar

---- e " Cross-Reference

<<<<< _5_, Server data
<<<<< @ Redundancy

““““ "'g Picture Tree Manager
Ji—:l Lifebeat Monitoring

----- 3‘51\ 0% Project Editor

~~~~ _] _1 Component List Editar
SFC

~~~~ P eb Mavigator

A @alarmActiveOp, Select ActiveX Control
A @alarmEmergend
A @AlarmEmergenj
/d\ @AlarmGone POL
A @AlarmGnneOp.F‘

A @AlarmHidden PDL
A @A&larmHiddenOp.POL
A @AlarmHiding,PDL

A @alarmHidingOp.PDL
/"\ @Alarmlournal POL

A @AlarmLocked.PDL

A @2&larmNew.PDL

A @AlarmMNewOp.PDL
A @2&larm0ld.PDL

A @AlarmOIdOp.PDL

A @AlarmOneLine PDL
A @alarmOperation.PDL
)h\ @AlarmProcess,PDL
A @alarmQuitPDL il

.
4 | 1} 3

Showy information column

Edit Favorites order

Properties

OS{1\Graphics Designery,

Figure 8-24

572 objectis)

3. Rename the pdl created in step 2 as required (UPS_ScreenWindow) and open it. The
"Graphics Designer" window opens.

4. In the "Standard" window of the Graphics Designer go to "Smart Objects" folder and

select "Picture Window".
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8.2 Application of screen windows in WinCC V7.4

5. Click on the "UPS_ScreenWindow.pdl" screen area to insert the "Picture Window".

A Graphics Designer - UPS_Screentiindow. pdl
Edit View Arrange Window Help

S0 o g

i, 7!'(/“’ A4

File Tools

LNREd b | & N
: Iz 3l m

=

@ @ 4 100% =~ :

aly & ok def 1 = ’:H-

UPS_ScreenWindow.pdl X

w | Standard

PICTURE WINDOW

Figure 8-25

S

‘7 Circular Arc

[T Rectangle

) Rounded Rectangle
A Static Text

-y]” Connector

= Smart Objects

-2 Application Windaow
..otk Contral

-.0LE| OLE object

-.[i| IFO Field

Jg Bar

- 2| Graphic Object
:g Status Display

o Text List

“":g Multiple row text
- H Combobox

m

Select the added screen window and go to "Properties > Miscellaneous".

7. For the "Picture Name" attribute assign "UPS1600_V3_0.pdI" and for the "Tag Prefix"
attribute assign the tag "UPS_Global" created during importing the HMI tag table (refer to
STEP 7 in Configuring Screen windows procedure). If your structure tag name is

'StructureTag' then add a '." at the end of your tag name
(<Structure tag name>.). Here, "UPS_Global.".

Propertiez | Events

, that is 'StructureTag.'

Picture Window Attribute
Adapt Picture

Picture scaling mode

Geometry
Miscellaneous

Static
Mo

Unifarm

Picture Mame

LPS1600_W3_0

Picture Offset X
Picture Offsety
Scroll Bar Position X
Scroll Bar Position

Scaling Factor

Tag Prefix

UPS_Global,

Server Prefix

Figure 8-26
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8.2 Application of screen windows in WinCC V7.4

Displaying the PROFINET diagnostic messages

In order to display the PROFINET diagnostic messages of the SITOP UPS1600 within the
screen windows, the respective WinCC project must already be configured for the display of
PROFINET diagnostic messages.

Information on the display and configuration of diagnostic messages in WinCC is available
under the entry ID 23730649
(https://support.industry.siemens.com/cs/ww/en/view/23730649).

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 are
available in the chapter 4 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).

8.24 Application of screen windows in WinCC V7.5

8241 Overview

To work with the library in WinCC V7.5 follow the similar process as mentioned in Application
of screen windows in WinCC V7.4 (Page 85), except opening the library UPS1600 V3-0
library WinCC V7.5 in place of UPS1600 V3-0 library WinCC V7.4.
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8.3 Application of faceplates in WinCC Comfort/Advanced V15.1

8.3.1 Prerequisites

Requirements

The following requirements must be met to use the faceplates in WinCC Comfort/Advanced
V15.1 and WinCC Comfort/Advanced V16:

® The HSP for the SITOP UPS1600 is installed in STEP 7 V15.1.

® S7 communication between SITOP UPS1600 and SIMATIC S7 controller is already
configured.

® Program blocks for STEP 7 V15.1 from LUPS1600 are integrated into the application
program and executable.

e |LUPS1600 is available on your computer.

Supported control panels
The faceplates are supported for the following control panels:
e TP700 Comfort/KP700 Comfort
e TP900 Comfort/KP900 Comfort
e TP1200 Comfort/KP1200 Comfort
e TP1500 Comfort/KP1500 Comfort
e TP1900 Comfort
e TP2200 Comfort
o MP277 8" Touch/MP277 8" Key
o MP277 10" Touch/MP277 10" Key
e MP377 Touch/Key
® WinCC RT Advanced V15.1

Supported languages
The faceplates support the following languages:
® English (USA)
® German (Germany)
® Chinese (PR China)
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8.3 Application of faceplates in WinCC Comfort/Advanced V/15. 1

8.3.2 Library for WinCC Comfort/Advanced

Library for WinCC Comfort/Advanced
The following objects are part of LUPS1600 for WinCC Comfort/Advanced:

Name Type Description

Comfort/Advanced | Faceplate from Types folder | Comprises of "LUPS1600_FpRTAdV" faceplate
and "LUPS1600_type300400RTAdv" HMI UDT

TagTablesRTAdv | Tag folder from Master copies | Comprises
LUPS1600_TagTableS7300400RTAdv and
LUPS1600_TagTableS712001500RTAdv

AlarmWindows Alarm views from Master Comprises 'Alarm windows' screen that has two
copies message windows to display the PROFINET
diagnostic messages of the UPS1600.

8.3.3 Integrating the faceplates

Overview
Hardware used:
e TP900 Comfort

An overview of the supported HMI control panels is available in the Precondition (Page 94).

Opening the library in WinCC V15.1

The procedure for opening the library in WinCC Professional V15.1 is explained in the
Content of the library for STEP 7 V15.1 (Page 49).

Inserting faceplates into a project

The following procedure describes how to integrate the faceplates from LUPS1600 into an
existing WinCC project:

1. Open the required project in "Project view".

2. In the "Project tree", open the "Screens" folder.
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3. Double click on "Add new screen" to add a new screen into your project.

Project tree m 4
Devices
&

* 7 Project_LUPS1600
K Add new device
gy Devices & netwarks
» |1 PLC_1 [CPU 1214C DC/DG/Rly]
» (1§ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DF]
~ [ HMI_1 [TP900 Comfort]
l]f Device configuration
3| online & diagnostics
1 Runtime settings
= ﬁ_—| Screens

|ﬁ"‘ Add new screen |

Figure 8-27

Open the new screen (Screen_1).

Project_ LUPS1600 » HMI_1 [TP900 Comfort]

Devices

[s5
B

= | ] Project_LUPS1600
“L' Add new device
gy Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RKY]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
~ [ HMI_1 [TP200 Comfort]
[lf Device configuration
%] Online & diagnostics
1 Runtime settings
e r_@ sScreens
ﬁr' Add new screen
|k ] Screen_1 |

Figure 8-28
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4.

8.3 Application of faceplates in WinCC Comfort/Advanced V/15. 1

In the "Libraries" window, select "Global libraries > LUPS1600 > Types > LUPS1600 >

WinCC > Comfort/Advanced > LUPS1600_FpRTAdv".

Libraries w0 p

» LLI Monitaring-and-control-abjects
» LL| Documentation templates
* [ L] LUPS1600
v [5 Types
= [&] LUPS1600
» |iz| STEPF
|5z Wincc

* iz Comfortfadvanced

Options A
—i

& Libraryview £ | ©
o

> | Project library 1
v Global libraries 1]
S g ) = RS Rl =

(1 . T = B ES =
» Ll Buttons-and-Switches w
» Ll Long Functions E

| » [=] LUPS1600_FpRTAdy |

» E LUPS1600_typeS7300400RTAdy
» [tz Professional
» [ Master copies

» [L§ common data
b | Languages & resources

Figure 8-29

5. Drag-and-drop "LUPS1600_FpRTAdV" into the opened screen in step 3.
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8.3 Application of faceplates in WinCC Comfort/Advanced V'15.1

Creating a connection to the data block for global data exchange

The following procedure describes how to create a connection to the data block for global
data exchange:

98

1.

In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies >
LUPS1600 > WinCC > Comfort/Advanced > TagTablesRTAdv >

LUPS1600_TagTableS712001500RTAdv".

Libraries

Options

& Libraryview £ -

syse] il

* Project library

w i Global libraries

» Ll Buttons-and-Switches
» LUl Long Functions
» Ll Monitaring-and-contral-abjects
» LUl Documentation templates
||| LUPS1600
» 31 Types
~ [ Master copies
w [&] LUPS1600
» ] STEF?
* Lz WinCc
* [t Comfortiadvanced
» o) Alarmitiindows
¥ |tz TagTablesRTAdw
Zg LUPS1600_TagTableS7300400RTAdy

FrhuD e W E

saelqr] E”

|5 LUPS1600_TagTable5712001500/TAdy |

» t:z| Professional
L'i Common data

4
¥ Languages & resources

Note
S7-300/400 PLC

For S7-300/400 PLCs, select "LUPS1600_TagTableS7300400RTAdv" instead of

"LUPS1600_TagTableS712001500RTAdv".
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2. Drag-and-drop "LUPS1600_TagTableS712001500RTAdV" into the "HMI tags" folder in
the "Project tree".

Project tree m 4

Devices

il

I:&T‘
y

~ | ] Project_LUPS1600 [~
B Add new device Tl
ﬁgh Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RIY]
» [ PLC_2 [CPU 315-2 PN/DP]
» ([ PLC_3 [CPU 416-3 PN/DP]
= [ HMI_1 [TP200 Comfort]
[IY pevice configuration
%] Online & diagnostics
1 Runtime settings
4 '__C] screens
¥ ﬁjj Screen management
___________ L» g HMitags |
Dé_’d Connections
4 HMI alarms

5 Recipes

Figure 8-30

3. Open "LUPS1600_TagTableS712001500RTAdv" in the "HMI tags" folder.
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8.3 Application of faceplates in WinCC Comfort/Advanced V'15.1

4. For the "UPS_Data" tag, set the global DB (UPS_Global) created in Procedure when
using an S7-1200/1500 (Page 63) from the Program blocks.

Project_LUPS1600 » HMI_1 [TP900 Comfort] » HMI tags » LUPS1600_TagTableS712001500RTAdv [3]

EEE
LUPS1600_TagTable5712001500RTAdv
Name a Data type Connection PLCname | PLCtag Address Access mode
- alarmhistory Int <ntemnal tag> <Undefined>
- alarmpending | Int <nternal tag> <Undefined>

4 » UPS_Data LUPS1600_typeU... [E]] HM_Conne... [i2] PLC_1 [UPs_clobal |_§}[ [=] <symbolic acces
«<Add news

~ (@ PLC_1 [CPU 1214C ...

~ .l Program blocks

N
[<] » § LUPS1600_UPS... PR
None
= = » @ UPS_Global [... e !
J Discrete alarms " Analog alarms " Logging tags » i) LUPS1600_FB [ o] |

» LUPS1600_UPS1600_DB
D Name Alarm text A » ¢ System blocks

» [@Technologyobjects
» (g PLCtags

o |

Note
For 300/400 PLCs,

e Forthe "UPS_Data" tag, make sure:
— the "Connection" is set to "HMI_Connection_1".
— the global DB number in the "Address" column is set to 2.

Project_LUPS1600 » 400_HMI [TP300 Comfort] » HHI tags » LUPS1600_TagTableS7300400RTAdy [3]

A
LUPS1600_TagTableS7300400RTAdv
Name a Data type Connection PLCnhame PLCtag Address Access mode Acquisition cycle  Logg
< alarmhistory  Int <Internal tag> <Und 15
a alarmpending  Int <Internal tag> <Und.. 1s

@ » UPs_Data  |LUPS1600_type57300400R... [E]] HMI_Connecti.. [ PLc.3 <. [][B2.08x0.0[+] <absolute accesss 500 ms =

<Add new
Operand identifier: _
08 e
Operand type: | DBX -
e —
Bit number: E

EA'x]
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5. Select the "UPS_Data" tag and go to "Properties > Properties > Settings" and make sure:
— the "Acquisition mode" is set to "Cyclic continuous".

— the "Acquisition cycle" value is set to "500 ms".

Project_LUPS1600 » HMI_1 [TP900 Comfort] » HM tags » LUPS1600_TagTableS712001500RTAdv [3]

% D+ %
LUPS1600_TagTableS712001500RTAdv
[ Name a Data type | Connection PLCname |PLCtag Address |#
<0 alarmhistory Int <nternal tag> <iIndefined=
<0 alarmpending | Int <nternal tag> <ndefined=
|<@ » UPS_Data LUPS1600_typel... |is|| HMI_Conne... | .| PLC_1 UPS_Global [ [k
<Add new>
(<] Il
a™ T
J Discrete alarms || Analog alarms || Logging tags
[ 10 Llaroe Llarmn teyt Llarmo clace Toooerian Toooe I
J Properties ” Events " Texts |
Settings
General Setti
Settings ngs
Range Acquisition mode: |C}-'c|ic continuous
Linear scaling Acquisition cycle: |500 ms
Values
Figure 8-31

6. In the "Project tree", open the screen with the inserted faceplate (Screen_1).

7. Select the faceplate on the screen in the display area and go to "Properties > Interface >
Data".
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8. Select the "UPS1600Data_S71200/1500" property and connect the "UPS_Data" tag in
"LUPS1600_TagTableS712001500RTAdv" under the "Dynamization" column.

» 5l Frogram blocks (o]l I

» "3 Technology objects
b g FLCtags
3 '_i Local modules
= [ FLC_2 [CPU 1214C DODCIRIY]
» gl Program blocks
b _4 Technology objects
b ':a FLC tags
» [l Local modules
v |24 1200_HMI [TP200 Cornfort]
- Ea HMI tags
=

Il I Mame ] Dats wpe_ |
None

T
T —

Properties Interface | Animation|

BeE - Ll
Name o] s
v Data : < i > [< i >
AlarrmviewBuffer I~ Edit ¢ Add new W |l %
AlarrviswPending 4 |
UPS1600DaE_S712001500 =5_Data =/, ||

UPS16000ata_S7300400

Figure 8-32

9. In a similar way, select the "UPS1600Data_S7300/400" property and connect the same
"UPS_Data" tag in "LUPS1600_TagTableS712001500RTAdv" under the "Dynamization”

column.
........ S ————— e S — 2
0, T o [ — ]
~ [ PLC_3 [CPU 416-3 PNIDP]
S Focrrblock 'New:&—l Data type ‘Address
» [ Technology objects S

[ Lupste... [E])

» g FLCtags
- » [ Local modules
LUPS1600_FpRTAdv_1 [Faceplate instance] [... [ 1200_HMI [TP300 Cornfort]

Properties Interface Animations Even| ~la GiMitage

» 2 Default tag table [6]

UPS1600Data_S7300400

HASE S
|7Nﬁmg 7[77!7‘7&5{@ value
| ¥ Data
I AlarmviewBuffer ™~
| slarraviewPending ™~
| UPS1600Data_S712007500 A
| -
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Note

¢ When the user performs the above operation, a red mark appears. It is not an error. It
means that the red marked property is not connected with the HMI. For example, in the
above case, the red mark indicates that the HMI control panel is connected with a
1200/1500 PLC and not with a 300/400 PLC.

e For S7-300/400 PLCs or S7-1200/1500 PLCs, the tags UPS1600Data_S7300400 and
UPS1600Data_S712001500 have to be mapped with the tag "UPS_Data" without fail.

Properties Interface || Animations || Events || Texts

2B E
Marne Staticwalue  Dynamization
> Data
AlarrrviewBuffer | alarrmhistory
alarmyviewPending i~ alarmpending
UPS16000&ta_5712007500 UF5_Data
UPSTa000ata_57300400 UF3_Data

Connecting trends of the faceplate with data sources

The following procedure describes how to connect the trends of the faceplate with data
sources:

1. In the "Project tree", open the screen with the inserted faceplate (Screen_1).
2. Select the faceplate and go to "Properties > Interface > Trends".

3. Select "Trends" and click on the marked area in the "Static value" column to open the
settings for the trends of the UPS1600 module.

Properties Interface ” Animations ” Events || Texts
tBE
Name | Static value | Dynamization
» Data
¥ Trends
N @ [tend 1 ]
Figure 8-33

The "Trend" window opens.
4. In the "Trend" window, add five trends in the "Name" column.
5. Set the "Trend value" to 600 to all the five trends.

6. In the "Source settings" column, click the drop-down. "Data source" dialog box opens.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7
Function Manual, 04.2020, ASE39439812-03-76 103



Application of the faceplates

8.3 Application of faceplates in WinCC Comfort/Advanced V'15.1

7. For the "Process values" click on the highlighted area to navigate to the HMI tags and
assign the following tags to each of the trends

— inputVolt

— outputVolt
— outputCur
— batteryVolt

— measuredChargeCur

6 Properties [} Info i) [ Diagnostics ||

Properties Interface || Animations |] Events " Texts |
HA=F =
Name } ‘ ‘Static value |D izati ‘
» Data
~ Trends
» Trends PN W [Trend_1 [[a
‘Name IS\yle ‘Trend b ‘Trend type Source settings | Side [Limits
] Trend_1 v/ [=] 100 [§] cyclical re... ]| linputvolt] BLeft [ FE R
<Add new>
Data source
Process values: |UPS_Data.inputVolt
— R £ | —
<] L[] » [ Local modules ‘Na [pesa ‘
~ [ PLC_3 [CPU 4163 PNIDP] a ";:vkesmm —
» [l Program blocks
,f' 9 - % i | deviceSwRevi... Byte
> 3 Technology objects 4@  endOfCharge... Real
» @ PLCE
> g Localaisodules i nputcur eal
| inputvolt | Real
~ [ HM_1 [TP900 Comfort] g-::ﬁ:c:: ne:|
~ [ HMi tags
oo =
~ g LUPS1600_TagTableS7300400R...
= < outputCur Real
|~ <@l UPS_Data - =
[ <[ ]
B Add new
Figure 8-34

8. Set the "Cyclic" value to 0.5.

Figure 8-35
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] Trend_3 600 Cyclical real ti... et
] Trend_4 NS 500 Cyclical real ti... Frocess values: |UPS_Data.inputVolt |§ﬁ
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9. In the "Style" column, select the trend color for the individual trends according to the

legend given below.

. UPS Input voltage

. UPS Output voltage

. UPS Output current
Battery voltage

. Battery charge current
Figure 8-36

8.3 Application of faceplates in WinCC Comfort/Advanced V/15. 1

10.In the "Side" column, select the value as "Right" to voltage tags and select the value as
"Left" to current tags assigned for the trends in step 6.

MName Style Trend w... Trend type Source settings | Side fifez=

=] Trend_1 600 Cyclical real ti... [inputvolt] Right ﬁﬂzi
| Trend_2 N 600 Cyclical real ti... [chargeCur] Left ﬁ;;‘
k| Trend_3 500 Cyclical real ti.. [batten®/olt]  Right A
=] Trend_4 N 600 Cyclical real ti... [outputCur] Left il
| Trend_s /\/ 600 Cyclical real ti... [outputVolt] Right ﬂ:.:|

frded ___i__.
(<] i (2]

Figure 8-37
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Activating the alarms display

106

1. In the "Project tree", double click on "Runtime settings" and select "Alarms".

Project_LUPS1600 »

Devices

—Eil;* |; s General
Services

¥ |7 Project_LUPS1600 (A 3creens
—f Keyboard

B’ Add new device
b Devices & networks Good Manufacturin...

» [ PLC_1 [CPU 1214C DCIDCIRIy] -
» [ PLC_2 [CPU 315-2 PN/DP] User administration
» (1§ PLC_3 [CPU 416-3 PN/DP]
= [ HMI_1 [TP200 Comfort]
[IY pevice configuration
%) Online & diagnostics

[Y Runtime settings|

4 ﬂj Screens

Language & font
OPC settings
Tag settings

Figure 8-38
2. Check the options "S7 diagnostic alarms" and "With event text".

Alarms

General

:

Buffer clearance in percent upon buffer overflow: |1
Acknowledgment group text: | QGR

Report:

Alarm class colors:

Download 57 diagnostics help texts:

System events

Display duration in seconds:

57 diagnostic alarms: With event text: @ |

D[QQ EAREIRNEY

SIMOTION diagnostic alarms:

Figure 8-39

Note

When configuring an S7-300/400 controller in TIA Portal, you also need to activate the S7
diagnostic alarm on the controller side.

The following entry describes how to proceed: 62121503
(https://support.industry.siemens.com/cs/ww/en/view/62121503), see Chapter 3.2.2
'Configuring CPU system diagnostic alarms', description 'Settings in STEP 7 Professional'.
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Configuring the alarms display

1.

SITOP UPS1600 Firmware V2.3: Faceplates and Communication Blocks V3.0 for SIMATIC STEP7

In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies >
LUPS1600 > WinCC > Comfort/Advanced > AlarmWindows >

LUPS1600_AlarmWindowsRTAdV".

Libraries

Options

= Library view 2]

sasell@'

* Project library

~ : Global libraries

L
» Ll Buttons-and-Switches
» LLI Lang Functions
» LLI Monitoring-and-control-objects
» Ll Documentation templates
* ||| LUPS1600
» [5] Types
= [ Master copies
« &2 LUPS1600
» [i:] STEP?
w 5] Wincc
¥ [t:] Comfort/advanced
* iz Alarmwindows

saueiqr] E”

I

| LUPS1600_alarmwindowsRTAdy |

» [tz TagTablesRTAdy
» [i:| Professional
» [} comman data
b | Languages &resources
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8.3 Application of faceplates in WinCC Comfort/Advanced V'15.1

2.

Project tree m 4

It
Y
1
' B
-

- v

k

Devices

* | 7 Project_LUPS1600
B’ ~dd new device
ﬁgh Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RIy]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
* [} HMI_1 [TP200 Comfort]

=3 Templates
E Fop-up screens

|3 slide-in screens

Device configuration
Online & diagnostics
Runtime settings
Screens

Screen ma nagement

L:a: Global screen |

Figure 8-40

EI Fermanent area

In the "Project tree", select "Screen management" and open "Global screen".

3. Drag-and-drop "LUPS1600_AlarmWindowsRTAdVv" into the global screen.

Libraries Ll 2

Figure 8-41

108

Options N
#| Libraryview 2] - 5
e
> Project library 2
~ : Global libraries
Fd WD e ER=M
» L] Buttons-and-Switches ;
» [L] Long Functions g
» Ll Monitoring-and-cantrol-objects g-
» L] Documentation templates 2
« || LUPS1600
» [5) Types ?:r
* | Master copies 3
~ [z LUPS1600 ‘é
b [Es| STEPZ o
¥ |tz WinCC =
ComfortiAdvanced ﬁ,i
‘tz AlarmWindows E
- [ LuPs1600_AlarmWindowsRTAdy | {5
b iz TagTablesRTAdv %
b 'tz Professional =
» [} Cornmon data
» | Languages & resources |
=
—
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8.3 Application of faceplates in WinCC Comfiort/Advanced V15.1

Configuring the alarms display call

1. In the "Project tree", under the "HMI tags" folder open
"LUPS1600_TagTableS712001500RTAdv".

Devices

et
el

[Ea

¥ ] Project_LUPS1600
I Add new device
Eﬂ-n Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RKy]
» [/ PLC_2 [CPU 315-2 PN/DF]
» (1§ PLC_3 [CPU 416-3 PN/DP]
¥ |5 HMI_1 [TP900 Comfort]
[IY pevice configuration
3| Online & diagnostics
1 Runtime settings
» ﬂj Screens
» f@] Screen management

2]

v [ HMI tags
% showall tags
B Add newtag table
é Default tag table [1]
L,;l! LUPS1600_TagTableS712001..}
’Z. Connections

2. For the tags "alarmhistory" and "alarmpending", check if the assigned "Data type" is "Int"

and the "Connection" is "Internal tag".

LUPS1600_TagTableS712001500RTAdv

~  Name a Data type | Connection

£ | alarmhistory Int <nternal tag>
<0 alarmpending | Int <nternal tag>
4 » UFS_Data LUPS1600_typeUPS1600... [E HMI_Conne... [
Figure 8-42
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3. Select the "alarmpending" tag and go to "Properties > Events > Value change". Check the

properties of the tag where in the "ShowAlarmWindow" function is inserted and its
variable "Object name" is assigned to the tag "Alarmview_UPS_Pending".

|§Properties || Info _,|||_| Diagnostics |
Properties Events || Texts |
T BEE X

fi&] value change

On exceeding

¥ ShowAlarmWindow

On falling below Object name Alarmview_UPS_Pending

Display mode Toggle

<Add function=

Figure 8-43

Similarly, check the properties of the tag "alarmhistory" where in the "ShowAlarmWindow"
function is inserted and its variable "Object name" is assigned to the tag
"Alarmview_UPS_History".

Open the screen (Screen_1) and select the faceplate. Go to "Properties > Interface >
Data".

5. Assign the "alarmhistory" tag to "AlarmviewBuffer" element.

S sio o oo

» L FLC_1 [CPU 41 6-3 FNIDF]
» [l FLC_2 [CPU 1 214C DOID .
w [ 400_HMI [TP900 Comfart]
~ [ HMI rags
» =55 Defaulttag table 1]

10:57:59 AM
12/31/2000

= | I di Int
~Eo il egienen| @ clompendng In

Properties Interface ” Animations I Eve

—_—

P A==
Name

¥ Data

AlarmviewBuffer

Alarmyviewfending

Figure 8-44

» 0 UP5_Data
<] wm ] [>]
—— [ show all | Edit | B Add new i [:]
[ IE
I~

6. Assign the "alarmpending" tag to "AlarmviewPending" element.
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Displaying the PROFINET diagnostic messages

To display the PROFINET diagnostic messages of the SITOP UPS1600 within the faceplate,
the respective WinCC TIA Portal project must already be configured.

Information on the display and configuration of diagnostic messages in WinCC TIA Portal is
available under the entry ID 62121503
(https://support.industry.siemens.com/cs/ww/en/view/62121503).

Activation of the PROFINET diagnostic messages of the UPS1600 is found in the "Device
view" of the UPS1600.

- X

..Jistributed VO » PROFINET IO-System (100): PNJIE_1 » DC-UPS-204_1

|§ Topology view ”Eﬂ‘h Network view ||[h‘ Device view |_

d¢ [DCUPs204 1 EIEEIEIRE =
1 2 S 4 5 & E
Rack_0
‘
,
— 5
{0 =t
[<][m] 1> | [100% b=l —§-— @
|§Properties ||"_i.'.|nfu y"&l Diagnostics |
J General “ 10 tags " System constants || Texts |
b General

Inputs

» PROFIMET interface ...

» Device configuration

¥ /0 data [ Hardware interrupt:
General
Inputs: .
Ewent name: \Hardware interrupt |

1iO addresses
Hardware identifier

» web server

T v T

Hardware interrupt: [— I

Priority l’(ﬁ |

Figure 8-45

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 is
available in the chapter 4 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).
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8.4 Application of screen windows in WinCC Professional V15.1

8.4.1 Prerequisites

Requirements

The following requirements must be met to use the screen windows in WinCC Professional
V15.1:

® The HSP for the SITOP UPS1600 is installed in STEP 7 V15.1.

® S7 communication between the SITOP UPS1600 and SIMATIC S7 controller is already
configured.

® All program blocks for STEP 7 V15.1 from LUPS1600 are integrated into the application
program and executable.

e |UPS1600 is available on your computer.

Supported control panels

The screen windows are supported for the following control panels:
® WinCC RT Professional V15.1

Supported languages
The screen windows support the following languages:
® English (USA)
® German (Germany)
® Chinese (PR China)
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8.4.2 Library for WinCC Professional

Library for WinCC Professional

The following objects are part of the master copy "UPS1600 TIA Library > UPS1600 Wincc >
Screens > Professional > ScreensRTProf" in LUPS1600:

Table 8- 3
Name Type Description
LUPS1600_ScrnWndwRTProf | Screen window Comprises the screen window
LUPS1600_ScrnRTProf Screen Comprises the screen 'LUPS1600_ScrnRTProf'
8.4.3 Integrating the screen windows

Overview

The following sections describe all the steps required to integrate the screen windows into a
WinCC Professional V15.1 project.

Target system used:
® WinCC RT Professional V15.1

Opening the library in WinCC V15.1

The procedure for opening the library in WinCC Professional V15.1 is explained in the
Content of the library for STEP 7 V15.1 (Page 49).
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Inserting HMI tag table in WinCC
The following procedure describes how to insert HMI tag table into the WinCC project:

1.

114

In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies >

LUPS1600 > WIinCC > Professional > TagTable
LUPS1600_TagTableS712001500RTProf".

Libraries

Options

WD »

sRTProf >

L Library view L2

0

syse| @|D|

? Project library

+ { Global libraries

FdhwDHE EEMW

» Ll Buttons-and-Switches
» LIl Long Functions
» [l Monitaring-and-contral-abjects
» LIl Documentation templates
* ||| LUPS1600
» 3] Types

- |

 Master copies
w [£:] LUPS1600
» [t STEF7
w [t Winco
b [t Comfortiadvanced
w |i:) Professional
» [t:| ScreensRTProf
w [i:] TagTablesRTProf

g LUPS1600_TagTable573004 00RTProf

» [} common data

=SILUPS1600_TagTableS712001500RTPro .

sauelqr] E"

¥ Languages &resources
Figure 8-46
Note

S§7-300/400 PLCs

For S7-300/400 PLCs, select "LUPS1600_TagTableS7300400RTProf".
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2. Drag-and-drop "LUPS1600_TagTableS712001500RTProf" into the "HMI tags" folder in
the "Project tree".

Project tree a4

Devices

aits

[

v [ 7 Project_LUPS1600 |
B Add new device il
gin Devices & networks

» [ PLC_1 [CPU 1214C DC/DC/RKy]
» [ PLC_2 [CPU 315-2 PN/DP]
» (1§ PLC_3 [CPU 416-3 PN/DP]
» (=i HMI_1 [TP200 Comfort]
~ [D PcSystem_1 [SIMATIC PC station]
: ﬂ'f Device configuration
') Online & diagnostics

= v [ HMI_RT_1 [WinCC RT Professio...
: [IY pevice configuration

1 Runtime settings =

4 ﬁj Screens
» _r{i] Screen management
- l@ HM tags |

%24 Connections

Figure 8-47
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Configuring connections of HMI tag table

The following procedure describes how to configure connections of HMI tag table:

1.

116

In the "Project tree", select "HMI tags > LUPS1600_TagTableS712001500RTProf" and
open the tag table.

Devices

et

[

= | 7] Project_LUPS1600
‘7‘ Add new device
gy Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RI]
» [ PLC_2 [CPU 315-2 PN/DF]
» [ PLC_3 [CPU 416-3 PN/DP]
» [=i HMI_1 [TP900 Comfort]
~ [0 PCSystem_1 [SIMATIC PC station]
: Y pevice configuration
'] Online & diagnostics
= v [ HMI_RT_1 [WinCC RT Professio...
: ﬂ'f Device configuration

[2]

1 Runtime settings
r r_|i'| Screens
r rﬁ] Screen management
v [ HM tags
%5 showall tags
I’ Add newtag table
[ Default tag table [27]
[Ey LUPS1600_TagTables712.. ]
D‘;_"i Connections

Figure 8-48

For the "UPS_Data" tag, set the global DB (UPS_Global) created in Procedure when
using an S7-1200/1500 (Page 63) from the Program blocks.

LUPS1600_TagTable5712001500RTProf

Name a Data type

Connection PLC name PLC tag Address Access mode Logged Synchronizi
@ » UPs_Data LUPS1600_typeU... [E)] HM_Conne... [ PLC 1 P5_Global|Elfi.: |+ ] <symbolic access>
<Add new> 5
g Program blocks
- Name
<] » @ LUPS1600_UPS160..
» @ UPS_Global [DB1] dage
Discrete alarms " Analog alarms " Logging tags St » UPS_Globa
» [£2] LUPS1600_FB

D Name
<Add new>

Alarm text Alg » i System blocks
» [ Technology objects
» [& PLCtags

3 T S Y

[~ showall
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Note
For 300/400 PLCs,

For the "UPS_Data" tag, make sure:
— the "Connection" is set to "HMI_Connection_1".

— the global DB number in the "Address" column is set to 2.
LUPS1600_TagTableS7300400RTProf

Name a Data type Connection PLCname | PLCtag Address Access mode Logged Synchrc
40 » UPS_Data  LUPS1600_types7...[ ]| HMI_Conne... [ PLC 2 <Undefined> [o][%DB2.0BX0.0 || ]|<absolute access>
<Add new>

operand densr: | ECHN

I DB number: |2| l

(<]

Operand type: |DBX .

iscrete alarms | Analog alarms [ Logging tags Address: [0 |
o Heme Alsrm texc Alarm class Btnumber: 0|
Edlx|

Inserting screen windows into a project

The following procedure describes how to integrate a screen from the library into an existing
WinCC project:

1. Op

en the project in "Project view".

2. In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies >

LU

]

0

PS1600 > WinCC > Professional > ScreensRTProf > LUPS1600_ScrnRTProf".

braries

ptions

| Library view [ Ol

syse] kit

b

Project library

b

Global libraries

]
»
]
»

-

FdhHD B

3

L] Buttans-and-Switches
Ll Lang Functions
LLI Monitaring-and-contral-objects

il
sauelqr] & "

|

LLl Documentation templates
L] LUPST600
» [ Types

w || Master copies

~ [ LUPS1600
[£z] STEPZ
v L] WinCC
» [tz Comfortiddvanced
~ |t Professional

¥ |i:| ScreensRTProf

| LUPS1600_ScenRTProf |

Fig

LUPS1600_ScrnwndwRTProf
b iz TagTablesRTProf
» [} Common data
¥ Languages &resources

ure 8-49
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3.

In the "Project tree", open the "Screens" folder of the HMI used in the project.

4. Drag-and-drop "LUPS1600_ScrnRTProf" into the "Screens" folder.

Devices
.3
=

Project tree

m

4

v | 7 Project_LUPS1600

i Add new device

EE,J Devices & networks
» [ PLC_1 [CPU 1274C DCDCRE]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
» [53 400_HMI [TP200 Comfart]
» (54 1200_HMI [TP200 Camfart]
» [ﬁ 400_PC-System_71 [SIMATIC PC station]
- [ﬁ 1200_PC-System_2 [SIMATIC PC station]
: ﬂf Device configuration
: %] online & diagnostics
= v [ HMI_RT_2 [WinCC RT Professional]
: Y pevice configuration

1 FRuntime settings
= r_[j Screens
ﬁ Add new screen

|[C] LUPS1600_ScrnRTProf |

F | Screen_1

S -

]

[

[2]
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8.4 Application of screen windows in WinCC Professional V15.1

Integrating screen windows into a project

The following procedure describes how to integrate the screen window from the library into
an existing WinCC project:

1. In the "Project tree", open the screen into which you want to insert the screen windows

(Screen_1).
Project tree o 4
Devices

[>]

~ 7 Project_LUPS1600

B Add new device

oy Devices & networks

[ PLC_1 [CPU 1274C DD CRIY]

(1§ PLC_2 [CPU 315-2 PN/DF]

(7@ PLC_3 [CPU 416-3 PN/DF]

[53 400_HMI [TP200 Comfart]

[54 1200_HMI [TPS00 Comfort] =

Eﬁ 400_PC-System_71 [SIMATIC PC station]

[ﬁ 1200_PC-System_2 [SIMATIC PC station]
ﬂf Device configuration

: %] online & diagnostics

= v [} HMI_RT_2 [WinCC RT Professional]

: Y pevice configuration

v w T T W Ow W

1 Runtirme settings
= r_[j Screens
ﬁ Add new screen
[] LUPS1600_ScrnRTProf

|E] Screen_1|
e

2. In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies >
LUPS1600 > WinCC > Professional > ScreensRTProf > LUPS1600_ScrnWndwRTProf".
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3. Drag-and-drop "LUPS1600_ScrnWndwRTProf" to the screen.

] Libraries
Options N
— 1=
#] Libranyview [£] - g_
. . =
= »  Project library g
- ~  Global libraries
SITOP UPS1600 - b E eERe=
g I I = S
» Ll Buttons-and-Switches 3
» [l Monitoring-and-control-objects =
age: LAY » L] Documentation templates >
_| = Ll Lups1e00
3 = -
sltage: " ~ 3 Types i
» [i: LUPS1600_STEP? &
» (i) LUPS1600_WinCC S
Arrent: EEED _ = = e
w [ Master copies o
v [t:] LUPST600_WinCe (i
sltage: 4 *VK, » [t LUPS1600_Comfortiadvanced =
N\ v [t:] LUPS1600_Professional =
\ v 2] LUPS1600_ScreenshTRrof =3
2
. *E %
arge voltage: i [ | LUPS1600_ScrnRTProf =
N | LUPS1600_ScrnWndwRTProf |
» [tz LUPS1600_TagTableskTProf =
............................ ren . =
Figure 8-50

4. Select the screen window and go to "Properties > Properties > General".

Assign "Tag prefix" variable with the "UPS_Data" tag present in
"LUPS1600_TagTableS712001500RTProf" folder.

|§, Properties |"_i.LInfo y"i] Diagnostics

JProperties |Animations “ Events " Texts |

g—} Property list

General
|
Contents Indepel
Appearance
SayouL Title: |UPS1600 In

Miscellaneous

T vl |

Figure 8-51

Displayed screen: I UPS1600

EIME,

Configurations: I

Eml,

Zoom factor: | 100 :I %

I Tag prefix IUPS_Data I

Process tag I
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8.4 Application of screen windows in WinCC Professional \/15. 1

Displaying the PROFINET diagnostic messages

To display the PROFINET diagnostic messages of the UPS1600 within the screen windows,
the respective WinCC TIA Portal project must already be configured.

Information on the display and configuration of diagnostic messages in WinCC TIA Portal is
available under the entry ID 62121503
(https://support.industry.siemens.com/cs/ww/en/view/62121503).

The activation of the PROFINET diagnostic messages of the UPS1600 is found in the
"Device view" of the UPS1600.

..Jistributed VO » PROFINET IO-System (100): PNJIE_1 » DC-UPS-204_1 - i X

|§ Topology view ||5Eh Network view ||[|'|‘ Device view |_

g+ [DcuPs-20a_1 7] B & H | =
|
1 2 S 4 5 & E
Rack_0
‘
,
] Bl
[<][m] 1> | [100% b=l —§-— @
|§Properties ||"_i.‘.|nfu y"ﬂ Diagnostics |
J General “ 10 tags " System constants || Texts I
b General lFigitie

» PROFIMET interface ...

» Device configuration
* i0 data [ Hardware interrupt:
General
: -
! Event name: IHardware interrupt ]
IO addresses I
F ; :
Hardware identifier v Hardware interrupt: | — =
» Web server Priotity ]15 I

Figure 8-52
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8.4 Application of screen windows in WinCC Professional /15. 1

Note

e When configuring an S7-300/400 controller in TIA Portal, you also need to activate the S7
diagnostic alarm on the controller side.

e The following entry describes how to proceed: 62121503
(https://support.industry.siemens.com/cs/ww/en/view/62121503), see Chapter 3.2.2
'Configuring CPU system diagnostic alarms', description 'Settings in STEP 7
Professional'.

e There can be differences regarding the S7-1200 diagnosis with respect to the S7-1500.

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 are
available in the chapter 4 of the SITOP UPS1600 User Manual
(https://support.industry.siemens.com/cs/ww/en/view/84977415).
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